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1 Overview

TreeSize  Professional  is  a  powerful  and  flexible  hard  disk  space  manager  for  Windows.
TreeSize Professional will help you to find out which folders are the largest dissipaters on your
drives and to recover megabytes of disk space. 

TreeSize Professional shows you 

the size, 

allocated space 

wasted space, 

the number of files, 

3D bar and pie charts, 

the last access date, 

the file owner, 

the NTFS compression rate 

and much more information for  several  folders  or  drives  you  choose.  TreeSize  Professional
offers a  search for  old,  big  or  temporary files  as  well  as  the facility  to  delete these files  or  to
compress  and archive them.  The application has  an intuitive Explorer-like user  interface,  it  is
fast, multithreaded, and supports Unicode and scheduled scans. You can print detailed reports,
and the Professional  Edition can export  the collected data to  Excel  and to  an  HTML,  XML  or
ASCII file. TreeSize Professional can be started from the context menu of every folder or drive.

For every button and menu item, a short description is displayed in the status bar. Pressing the
F1 key will open the context sensitive help.

2 Installation

To install TreeSize Professional, execute the setup file and follow the instructions. The minimum
requirements are Windows XP.  The setup program  will  copy the necessary files  to  your  hard
disk  and  will  create  a  new  program  group  in  the  Start  Menu.  TreeSize  Professional  may  be
uninstalled using the Software applet in the Control Panel of Windows. The installation key needed
for installing the registered version is printed on the disk label and is also available online in our
customer's area.

Portable installation

It is  possible to install the Professional  Edition as  portable  version,  e.g.  on an USB Stick.  The
settings will then be saved in the install location.

3 Quickstart

After the installation TreeSize Professional can be started using the Windows Start menu or the
right  click menu of  a  folder  or  drive.  We will  now  explain  the most  important  elements  of  the
TreeSize Professional main window:
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1. On this toolbar the user can select which drive or path should be scanned. Press the button
with the arrow on the right to start scanning. TreeSize Professional here remembers the last
paths that have been used.

2. Here the user can get an overview of the currently scanned drive. This and the other toolbars
can be turned off in their context menu.

3. The Chart page shows a pie or bar chart of the currently selected directory. Use the context to
show a toolbar with advanced charting features.

4. The "Details"  tab shows  detailed information about  the  sub-folders  and  the  files  inside  the
currently selected folder.

5. The "Extensions" tab shows the size information grouped by file types. That way you will get
an overview what file types take up most of the space. 

6. The "Users" tab shows the size information grouped by user names. This allows you to  see
which users use most of the disk space.

7. The "File Ages" tab shows when folders have been created.

8. The Top 100 files lists the 100 largest files in the scanned directory tree.

9. The file system tree of  the scanned folder  or  drive gives  you an immediate overview  of  the
size of each folder.

10.The  drive  panel  provides  an  overview  of  all  local  and  mapped  network  drives.  Additional
network drives can be added using the context menu. Double click on a drive to start a scan
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in TreeSize Professional.

11.The status bar informs you about the allocated and free space of  the current  drive,  the file
system type, etc.

12.  The  "History"  tab  shows,  how  scan  results  of  a  special  directory  branch  have  changed
through time. This feature allows a dynamic analysis of the patterns of utilization over  a  longer
period of time.

4 What's New

Changes in V5.5.5 (27 Mar 2012)

Custom  File  Search:  The values  for  min and max size now  also  work  for  directories.  This
allows you  e.g. to easily find folders that do not contain any files by setting the max size to 0
and checking only "Directory" in the Attributes list.
Bug fix - File Search: Some MD5 checksums could be missing in exported files.

Bug fix: Editing the execution time of an existing scheduled TreeSize task did not work.

A few minor fixes have been incorporated.

Changes in V5.5.4 (27 Jan 2012)

The new command line option /EXPORTDRIVELIST now  exports  the contents  of  the drives
panel to a text file.
Bug fix: When selecting "Remove from TreeSize temporarily" in the right  click menu of  the "
Details" list sometimes too many items disappeared from the list.
Bug fix: Pressing the "Del" key in the "Details"  list  deleted only the selected files  if  both files
and folders were selected.
Bug fix: TreeSize Professional now follows Windows DFS shares correctly again and shows
their target path in the tooltip window.
Bug fix: The command line option /FILEAGESCHART no longer produces empty charts.

Bug fix - File Search: Using a wildcard pattern like "C:\Temp\*.txt" in the Custom File  Search
now produces the expected result and lists all text files in the directory branch "C:\Temp".
A few minor fixes have been incorporated.

Changes in V5.5.3 (24 Oct 2011)

Bug fix: An occasional repaint problem of the folder dropdown box on the top left of  the main
application has been fixed.
Bug fix - File Search: "Edit > Check all matching a pattern"  now  also works  correctly for  the
duplicate search and now considers not only the full path but also the file  name.  This  allows
using more simple patterns like "New*.txt".
Bug fix - File Search: The behavior of the command line option /MOVETO has been improved.

A few minor fixes have been incorporated.

Changes in V5.5.2 (10 Aug 2011)

Bug fix: Saving an XML report for a virtual root folder caused an error, this also applied to the
command line options /GROUPSCANS /XML.
Bug fix -  File  Search:  An error  was  fixed  that  occurred  when  merging  the  permissions  for
deduplicated files.

http://en.wikipedia.org/wiki/Distributed_File_System_%28Microsoft%29
http://en.wikipedia.org/wiki/Distributed_File_System_%28Microsoft%29
http://en.wikipedia.org/wiki/Distributed_File_System_%28Microsoft%29
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Bug fix - File Search:  A possible  error  was  fixed that  could occur  after  using "Check all  but
newest" from the right click menu of the Duplicate Files search.

Changes in V5.5.1 (28 Jul 2011)

Bug fix: The chart on the "History" tab is now working again for mapped network drives. 

Bug fix:  If  a  [Files]  item  is  deleted  using  the  right  click  menu,  it  is  now  removed  from  the
Directory Tree.
Bug fix:  When performing multiple  scans  from  the command line  with  multiple  /PIECHART
command line options, then the exported charts sometimes contained the wrong content.
Bug  fix:  Entering  paths  like  \\Server\A*  in  the  edit  field  on  the  top  left  of  the  TreeSize
Professional window is now working again.
File  Search:  The custom  file  search now  allows  again a minimum  value of  "0"  for  the  date
fields  "Since XX days".  This  allows  to  search for  files  that  have  been  created,  changed  or
accessed today.
Personal Edition: The menu item for comparing XML reports is now available again.

Changes in V5.5 (18 Jul 2011)

The new columns "Inherited Permissions" and "Own Permissions" have been added to  the "
Details" tab and all  export  options.  The column "Own permissions"  simplifies  finding folders
that do not inherit all their permissions from their parent folder. Both columns are not activated
by default, but can be enabled using the context menu of the list header or at "Tools > Options
> Columns/Export".
The new column "Alternate Data Streams" in the Details list shows the size of NTFS alternate
data streams in a file.
The columns  "Quota  Limit"  and  "Quota  Usage"  have  been  added  to  the  "Users"  list.  This
allows a quick overview about the usage and limit of the Windows built-in quota features from
within TreeSize Professional.
The "File" menu now includes a list of recently scanned paths and recently saved XML reports.

You can now  scan paths  like "S:\Users\R*"  or  "R:\*\MyVideos".  Only one root  folder  will  be
created in this case.
File Search - Move Checked Files: It  is  now  possible  to  burn the checked files  to  an optical
media. 
File  Search  -  Move  Checked  Files:  Because  of  many  customer  requests,  it  is  now  also
possible to copy all checked files to a different location instead of moving them.
File Search: It is  now possible to check or uncheck all  search results  which are matching a
certain pattern using the "Edit" menu.
File Search - Duplicates Files: It is  now also possible to search duplicates solely by their  file
name.
File  Search  -  Duplicates  Files:  The  deduplication  feature  now  has  an  enhanced  dialog.  It
shows the number of all checked duplicate files and the disk space that will be recovered. You
may  specify  a  log  file  that  logs  all  performed  operations  in  detail.  Furthermore  you  may
configure in detail how to handle duplicates that are not located on the same volume.
File Search - Duplicates Files: When deduplicating files using hardlinks now a union set of the
original access privileges is applied to the remaining file, so that all users can still access the
resulting file.
File Search - Oldest Search: You may now alternatively specify the minimum age of  a  file  in
number of days instead of a certain date.
The saved XML reports now include the owner of each folder in case the file owner statistics
was turned on in the Options of TreeSize Professional.
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TreeSize Professional is no longer shown in the context menu of virtual folders like the recycle
bin. It is now also available in the background context menu of folders.
Bug fix: The command line option /SCAN did not work in combination with /EXCEL and /SAVE.

Bug fix: The command line option /TREEMAP did not work in combination with /NOGUI.

Bug fix:  Right  clicking on a very large file  could cause the  application  to  freeze  for  several
seconds as this triggered calculation of checksums shown in the "TreeSize" submenu of the
right click menu.
Numerous further improvements and a few minor bug fixes have been incorporated.

Changes in V5.4.4 (13 Dec 2010)

Now the language which is chosen in the first step of the installer decides about the language
of the user interface, the regional settings of the system are no longer taken into account.
Exporting Excel files is faster now, especially for a large amount of data (>60.000 rows).

Bugfix: After clearing the exclude filter at "Tools > Options > Include/Exclude", the necessary
rescan is now performed correctly.
Bugfix - File Search: The checkbox "Save only checked items" in the dialog of "Save Results"
now has the desired effect of exporting only those items which have been check-marked.
A few minor fixes and improvements have been incorporated.

Changes in V5.4.3 (23 Nov 2010)

The function "Update this  branch (Shift+F5)"  from  the context  menu of  a  folder  is  now  also
working for a directory tree loaded from an XML file.
Bugfix:  When a saved XML report  of  a  server  is  loaded that  is  currently  not  reachable,  the
delays that occur are minimized now.
Bugfix: A rare error when loading a saved XML report has been fixed.

Bugfix: If the TreeSize File Search is added to the Explorer context menu using the option at "
Tools > Options > Miscellaneous", the correct caption for this menu item is used now.
Bugfix - File Search: The results of the search type "Internet Files" were possibly incomplete.

A few minor fixes and improvements have been incorporated.

Changes in V5.4.2 (22 Oct 2010)

Bugfix: An error when exporting the settings at  "Tools  >  Options  >  Miscellaneous"  has  been
fixed.
Bugfix  -  File  Search:  When  moving  files,  the  "Yes  to  All"  button  is  confirms  all  further
confirmation dialogs of the same type.
A few minor fixes and improvements have been incorporated.

Changes in V5.4.1 (06 Oct 2010)

The default sort order of the "Top 100 Files" list is now again descending by size.

Improved saving and restoring of the toolbar positions

File Search: Scrolling in the duplicate list could be slower than in V5.3 if the columns "Creation
Date" or "Last Access" were visible.
Bugfix: On a few systems with Outlook 2003 an error in MSMAPI32.DLL occurred on startup of
TreeSize Professional.
Bugfix: The toolbar button for copying the history chart to the clipboard was always disabled.

Bugfix:  Fixed rare OLE exception ("Not  implemented")  caused by the code for  showing  the
progress  in  the Windows  task bar.  Affected were some Citrix systems  and Windows  2008
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Server on which TreeSize Professional was started as RemoteApp.
Bugfix:  Removing single  points  from  the  "History"  tab  via  the  context  menu  ("Remove  this
point") could lead to an error.
A few minor fixes and improvements have been incorporated.

Changes in V5.4: (21 Sep 2010)

Paths that are exported to Excel  files are  now exported as clickable  hyperlinks.  This
allows you to quickly jump to the appropriate path in Windows Explorer.
The automatic mode for size units ("View" > "Automatic Units") is  now also supported for the
export  to  Excel  files.  Please  note  that  it  will  be  difficult  to  do  calculations  based  on  these
values.
Personal Edition: TreeSize Personal now scans network drives if the computer running
TreeSize  Personal  is  not  part  of  a  Windows domain  and the  remote  system is not  a
Windows server. This enables customers of the Personal Edition to scan network drives  in
their home network, including NAS systems based on Linux and Samba 3.
All lists, including the results lists of the file search,  can now  be  saved in  HTML and RTF
format by choosing the appropriate format in the "Save" dialog.

All printed lists now include the icons, text formatting and indents.

Printed reports now show compared scans in red and green, just like on the directory tree, if
the option "Use bold Text and Colors for Printed Reports too" is activated in the Options dialog.
The  tree  map  on  the  "Charts"  tab  now  not  only  supports  drag  operations  but  also  drop
operations. Additionally, drag operations with the right mouse button are possible as well. The
right click menu of the tree map now offers the possibility for elements like *.doc to list all files
that belong to this element.
The progress of the currently selected scan is now indicated in the Windows 7 task bar.

The  indicated  progress  of  a  scan  is  now  calculated  more  exactly  by  using  the  results  of
previous scans (if available).
Options: On the new tab "File Groups" the file  groups shown on the "Extensions" tab can
now be customized.

The incremental search, which is started when you type characters in the directory tree on the
left, now searches all sub folders, even the ones that are not visible or expanded. This allows
you to quickly locate folders by starting to type their first characters.
A new option (Tools > Options > View) allows you to display folders containing long paths
(> 255 characters) in red.

Drives are now displayed in the directory tree including the volume name, e.g.: C:\ (System)

The new  command line option /SHEETNAME allows  you to  specify  the  name  of  the  Excel
sheet that will be added when using the /EXCEL command line option. See help for details.
History: The new option "Purge Old History Values"  in  the context  menu of  the "History"  tab
can be used to permanently remove older values from the chart.
The small chart  on the bottom  of  the "Extensions"  and "Users"  tab can now  be exported in
scheduled tasks as well.
The  Windows  defragmenter  can  now  be  started  from  the  TreeSize  Professional  "Tools"
menu.
A new option (Tools > Options > Startup) allows you to always start TreeSize Professional
as  administrator  for  Windows  7  and  Vista,  not  just  if  the  appropriate  entry  from  the
Windows Start menu has been used.
If TreeSize Professional is  started non-elevated and it  encounters  a folder  which it  does  not
have access to, it now asks the user if TreeSize should be started again with  administrative
privileges.
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The Include Filter at "Tools > Options  >  Include/Exclude >  Include"  now  supports  paths  and
path fragments, too, not only file extensions. A dialog for editing the pattern more comfortably
can be opened using the button on the right.
The shortcut for copying the selected entries of the Details list to the clipboard as text is  now
Shift+Ctrl+C.  Ctrl+C  in  the  "Details"  list  now  copies  the  selected  files  or  folders  to  the
clipboard, just like the Windows Explorer.
The shortcuts Alt+Left, Alt+Right and Alt+Up now behave like in Windows 7 Explorer.

In the Restricted mode, which can be started using the command line switch /RESTRICTED,
the Explorer context menu is now available in  the directory tree,  the Details  list  and the Top
100 list.
A new  option under  "Tools"  >  "Options"  >  "Miscellaneous"  allows  you  to  add  the  TreeSize
Professional File Search to the Explorer context menu of folders and drives.
File Search: The Duplicate file search now supports SHA256 check sums. While it is  very
unlikely that  the MD5 hash algorithm  produces  the  same  hash  value  for  different  files,  the
SHA256 algorithm further reduces the statistical risk of such hash collisions.
File Search - Custom File search: The tabs of the custom file search that  have filters  set  (=
have actual influence on the search result) are now marked by a bold text in their tab.
File Search: The File Search now decides, in a more intelligent way, if it should match a given
pattern against the full path or just against the file name. In previous versions it was difficult to
keep  certain  substring  matches  out  of  the  search  results.  Additionally,  you  can  now  use
quotes around your search pattern and so force a strict matching.
File Search: It is now possible to search for files that do not have a certain attribute set.

File Search: The export format of the Duplicate files list has  been improved:  The groups  are
easier to identify because files are indented now.
File Search: A new option "Show  Time with  Date Values"  was  added to  the "View" menu.  It
allows you to turn on or off the displaying of the time values next to the date values.
File  Search:  The right  click menu of  the  drive  list  on  the  "Search  Options"  tab  now  has  a
feature to import and add paths from a text file.
Bugfix - File Search: If the "Move Checked files" function needed to create a new directory in
the root of a drive, it sometimes had the hidden and system attribute set.
The support  for  Windows 2000 has been dropped  because Microsoft  dropped  it  in  July
2010.  TreeSize  Professional  V5.3.4,  which  is  compatible  with  Windows  2000,  remains
available in our customers area for registered customers with valid maintenance.
Several minor improvements have been incorporated.

Changes in V5.3.4: (21 Jan 2010)

If  single  files  are  deleted  from  the  "Details"  list,  the  size  in  the  directory  tree  will  now  be
updated even if "Automatic Updates" are turned off.
Bugfix:  On  systems  that  are  not  part  of  a  Windows  domain,  delays  could  occur  when
expanding  items  in  the  directory  tree  or  when  the  information  for  the  long  hint  text  was
compiled.
Bugfix:  In  the  column  "Permissions"  sometimes  usernames  were  not  displayed  correctly,
instead "S-1-0" was displayed.
A few minor improvements have been incorporated.

Changes in V5.3.3: (11 Dec 2009)

Bugfix - File Search: A long list  of  duplicate files  could contain  invalid  items  in  some cases.
This caused an error if the list was scrolled to the bottom or if it was exported to a file.
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Bugfix: "Show Files" in the right click menu of the "Age of Files" chart as well as a double click
on one of the bars produced empty result lists on some systems.
Bugfix - File Search: When loading search options from an XML file, the date values were not
restored correctly on some systems.

Changes in V5.3.2: (24 Nov 2009)

Environment variables can now be used in paths to be scanned, e.g. if they are entered in the
directory dropdown box in the top left of TreeSize or passed via command line.
The function to  list  files  of  a  user  /  extension /  file  age interval  now  takes  the  currently  set
exclude filters into account.
File Search: The search progress is now visualized in the Windows 7 task bar icon.

File Search: The Explorer context menu is now also displayed if more than one file is selected,
as long as the selected files are on the same drive or share.
Bugfix: Tools > Options > Include/Exclude > File Types: Multiple patterns separated by blanks
were no longer working correctly.
Bugfix: The exclude filter did not work for patterns with an absolute path. As  a consequence,
the feature "Remove from TreeSize (permanently)" in the right click menu of the directory tree
did not work too.
Bugfix: The shortcut "Ctrl" + "-" for the feature "Remove from TreeSize (permanently)" did not
work.
Bugfix - File Search: It was no longer possible to enter a server name as origin for the search
(e.g. \\Server1).
A few minor bug fixes and improvements have been incorporated.

Changes in V5.3.1: (15 Oct 2009)

Bugfix: The regular check for update could crash TreeSize Professional on application start.

Bugfix: After using "File > Compare With XML Report", folders could appear multiple times in
the directory tree.

Changes in V5.3  (12 Oct 2009)
TreeSize Professional has passed the "Compatible with Windows 7" logo test.
Introduced new toolbar buttons "Back" and "Forward". You can use these buttons to navigate like in
the Windows Explorer.
In the directory edit field in the upper left corner of TreeSize Professional it is now possible to enter
multiple paths at the same time by separating them using semicolons. Each of these paths may contain
wildcards. Example:  d:\data\;e:\logfiles\;h:\user*\
Top 100 List: Added columns Creation Date (by default visible), Attributes, Version, Permissions (by
default not visible)
Added column "Full User Name" (by default visible) and "User Comment" (by default not visible) on the
"Users" page. Use the column header context menu to adjust columns.
The "Printed Report" and the lists printed using the "Print" button above the "Details" list now also contain
the icons.
Added possibility to export a subbranch of the scanned file system to the right click menu of every folder.
Under "Tools > Options > Columns / Export" there is a new export type for CSV files now. This way CSV
files can now be configured independently from the text export.
You can now export the user settings to a file ("Tools > Options > Miscellaneous > Settings") and
import them later, or provide them to another instance or user of TreeSize Professional. You can also
reset the user settings to the factory settings here.
The drives panel is no longer blocking TreeSize Professional on startup for a while if an unreachable
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network path is included in the list.
Introduced new menu "Edit" to the main menu. It provides similar features like the Windows Explorer
"Edit" menu and includes: "Cut", "Copy", "Paste", "Select All" and "Invert Selection".
F5 now only updates the "Details" list if the Details list is focused. Otherwise it will, like before, perform a
rescan of the currently selected directory branch.
Improved progress dialogs when printing or exporting. They showed a wrong progress sometimes.
Added new command line option /OPTIONS to pass formerly exported user settings to the application. 
(Professional edition only)
The new command line switch /APPENDTOFILES will make TreeSize Professional to always append its
output to existing files when exporting a list in text format. (Professional edition only)
In file names passed on the command line, e.g. for the Excel or XML export, now environment variables
can be used. (Professional edition only)
Charts: The colors assigned to the chart are now memorized for the next start. The context menu of the
chart has an option to reset the colors to their default values.
Charts: The bar and pie charts now also display Unicode characters.
Charts: All charts can now be copied, saved or printed through their right click menu.
Charts: Introduced new buttons in the toolbar of the "History" and "Age of Files" tab to (de)activate the
gradient, patterns and hint marks.
Charts: In the right click menu of the pie chart you can now define the threshold for items to be merged in
the "Others" slice.
Charts: You can now zoom the active chart by using the mouse wheel while the "Ctrl" key is pressed.
Charts: Saving to a PNG file is now supported.
Charts: You can now scroll the treemap by keeping the space bar pressed while dragging the treemap
using the left mouse button, similar to imaging software (e.g. Photoshop).
A new feature "Manage Scheduled Tasks"  has been added to the "Tools"  menu of the  main  application
and the File Search. It  allows to edit  or manage previously  created TreeSize tasks.  (Professional edition
only)
Schedule TreeSize Tasks: Added "Execute this  Task"  to the right  click  menu of the "All Tasks"  list  and
the box showing the current command line. (Professional edition only)
Schedule TreeSize Tasks: Added the new functions "Activate Task" and "Deactivate Task" to the context
menu of the "All Tasks" page. This state is now also shown by the icon of each task in the list. 
(Professional edition only)
File Search: Use the new option "Tools > Schedule Current Search Options" to open the TreeSize
Schedule Task dialog with the currently configured search settings. (Professional edition only)
File Search - Duplicate Files Search: Introduced new "Deduplicate Checked" button on the right side of
the file search window. This button replaces all checked duplicates with links to the same file. If the files
are on the same partition, then all files will be hardlinks to the same content. If creation of a hardlink is
not possible, a symbolic link is used under Windows Vista and later. If this is not possible too, a
Windows shortcut will be created instead as fallback.
File Search: Added column "Author" to the result lists which shows the author included in most MS
Office files.
File Search - Move Checked Files: We enhanced the option "Leave shortcut at original location", so that
you can now decide to leave a (hard) link instead of a Windows shortcut.
File Search - Move Checked Files: Introduced new option "Automatically rename existing files". If this
option is activated, files will be automatically renamed if a file with the same name already exists in the
destination.
File Search - Move Checked Files: We introduced a new option "Preserve directory structure". This  option
is  activated  by  default,  because  the  directory  structure  was  preserved  in  former  versions  of  TreeSize
Professional. You can now deactivate this option to move files directly to the chosen destination.  Existing
files  located  in  the  destination  will  be  renamed  (e.g.:  "..\file.name"  ->  "..\file.bak0.name")  if  the  option
"Automatically rename existing files" is activated.
File Search - Move Checked Files: When moving files from one drive to another, the creation date is now
preserved.
File Search - Custom Search: You can now search for folders by checking the "Directory" attribute on
the "Size/Attributes" tab.
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File Search - Custom Search:  You can now search for files  and folders  having the  attribute  for  Reparse
Points / Mountpoints set.
File Search: The command line options  /SIZEUNIT and /NOUNITS are now also supported in the File
Search. (Professional edition only)
File Search: The /FILTER command line option no longer sets the patterns for the temporary file search, it
now sets the patterns of the custom file search and allows an easy file search for certain file types or
patterns. (Professional edition only)
Bugfix: In the right click menu the "Open" command for folders ("Open containing folder" for files) did not
work on 64Bit Windows systems.
Bugfix: File Search: When using the "Move Checked Files" function in combination with the "Preserve
permissions of the original file" option, in rare cases an error could occur.
Bugfix: When editing the scheduled time or day or trigger type (once, daily, weekly) of an existing task in
the "Schedule TreeSize Task" dialog ("Tools > Schedule TreeSize Task"), this change was not stored.
Bugfix: The command line option /TREEMAP was not working in combination with /NOGUI.
Bugfix: When terminating a duplicate file search with MD5 checksums before it was finished, the result
list could incorrectly include some entries that were not checked for equal file content.
Many further enhancements and a few minor bug fixes have been incorporated.

Changes in V5.2.3  (31 Mar 2009)
The command line parameters /USERSLIST, /EXTENSIONSLIST and /TOPFILESLIST now support writing
to Excel files.
File Search: While calculating MD5 checksums, the duplicate file search now shows the number of
remaining files in the status bar.
File Search: The "Duplicate Files" result list now shows the number of files and their summarized size in
the status bar, and no longer the number and size of file groups.
File Search: If more than one file is selected, the number and size of the selected files is shown in the
status bar.
Bugfix: File Search: The duplicate file search occasionally locked when identifying duplicate files using
MD5 checksums.
Bugfix: File Search: A problem has been fixed when using the "Move Checked" function for complete
folders that were moved to a ZIP-File.
Bugfix: If a user defined cluster size was reverted to "Original" in the "Options" dialog, this was not
applied to current scans even if a rescan was performed.
Bugfix: A problem with the view of the bar chart when it was displaying many folders has been fixed.
A few minor bug fixes and improvements have been incorporated.

Changes in V5.2.2  (17 Feb 2009)
Now the shadow of the pie chart is deactivated as well if the gradient in the background of the chart is
deactivated
Bugfix: The total and free space was no longer shown for UNC paths in the drives panel.
Bugfix: The file extensions and users statistics was no longer working for virtual root folders
Bugfix: If a single file was dragged from the "Details" list to the directory tree, an error could occur.
Bugfix: When scrolling in the bar chart that had a lot of elements, the chart was corrupted.
Bugfix: On systems that had the Windows printer spooler service not running an error message occurred
at the startup of TreeSize.
Bugfix: Deactivating the statistics for "Age of Files" in the Options dialog did not persist when TreeSize
was started again.
Bugfix: The option "Include only files created in the past XX days" did also check the creation date of
folders in V5.2 and therefore returned unexpected results.
A few minor bug fixes and improvements have been incorporated

Changes in V5.2  (04 Feb 2009)
File Search: The "Move Checked Files" feature is now able to handle paths of more than 255
characters and optionally is able to preserve the permissions of the moved files.
File Search: The "Move Checked Files" feature as well as the /MOVETO command line option
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(Professional Edition only) now allow to pass the checked files to any executable file as parameter.
This offers system administrators a lot of possibilities to manually and automatically process the search
results of a TreeSize Professional File Search.
File Search: The search results can now be saved to a native Excel file. If multiple result lists are
saved, each list will be placed on a separate sheet.
File Search: With a new option on the "Move Checked Files" dialog you can now automatically remove
empty parent directories that are left over after moving / deleting the checked files.
File Search: In the list of search patterns of the "Custom Search" type it is now possible to use patterns
that include fragments of a path, e.g.: "C:\Windows\*\*.exe" or "*\Temp\*.old"
File Search: The ZIP files created by the "Move Checked Files" feature are now able to store Unicode
file and folder names in the ZIP file. ZIP files containing Unicode paths can only be unzipped properly
by Unicode compatible ZIP tools like WinRar or WinZip.
File Search: It is now also possible to start the File Search with Full administrative privileges from the
Windows "Start" menu and the "Tools" menu of TreeSize Professional.
File Search: In the "File" menu it is now possible to print a result list or to copy its contents to the
clipboard. Use the right click menu of the lists to copy only the selected items.
File Search: It is now possible to copy the contents of the drive list to the clipboard using its right click
menu.
File Search: The /DATE command line parameter is now also supported for the file search. This way you
can automatically add the current date and time to file names specified for the /SAVE parameter or the /
MOVETO parameter with a ZIP file. /DATE will change all file names that appear after its occurrence on
the command line.
The new command line options /NOHEADERS and /NOUNITS allow to omit the headers and units
from exported files, which simplifies getting plain data for later postprocessing.
A new option allows to exclude files that are marked as Offline. Offline files are often not physically
present on the disk or are only cached temporarily on the local disk.
The new command line option /LISTSEPARATOR allows to define the separator that is used when
exporting text files.
The new command line parameter /EXPORTDRIVELIST has been added, which saves the contents of
the drives panel to a file.
Now the Excel 2007 format (file extension XLSX) is supported by TreeSize Professional. This enables
you to export Excel files with more than 65,000 rows.
All Excel files saved by TreeSize Professional now have numbers and units separated, which
simplifies performing calculations with size values. When saving the "Details" list to an Excel file now
only the selected items will be saved if more than one item is selected.
All pattern editors (e.g. View > Options > Include/Exclude, the custom file search, etc.) now have
checkboxes in front of their patterns. This allows to deactivate certain patterns temporarily without the
need to delete them.
You can now choose to install the Professional Edition as portable version, e.g. on an USB stick. The
settings are stored in the application path in this case.
TreeSize Professional now stores the user settings in an XML file in the user's profile. 
Treemap: Added OLE drag support to the treemap chart. Drop support will follow in the next version. This
allows dragging folders from the treemap to other locations.
Treemap: Ctrl + und Ctrl - can now be used to zoom the treemap. The cursor keys, Home, End, PgUp
and PgDown can be used to scroll the zoomed chart.
Added a context menu item that allows to copy the underlying data from the "Age of Files" chart to the
clipboard as text.
Ctrl+X now executes the Windows Explorer "Cut" operation in the directory tree and the "Details" list. The
keyboard shortcut for "Automatic Units" has been reassigned to Ctrl+U.
When saving a scan to an XML file, the XML stylesheet is now copied next to the exported XML file and is
referenced using a relative path. This simplifies using the XML files on systems not having TreeSize
Professional installed.
Several minor improvements and bugfixes on the treemap, the bar and the pie charts.
The memory consumption for storing the file types and the user statistics has been reduced.
Bugfix: In the "Duplicate Files" search, when checking all selected items using the context menu (if file
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group items get selected as well) the check state of the group items was set too, which resulted in an
error when using the "Move Checked Files" function.
Bugfix: Fixed a memory leak that occurred on Windows Vista when scanning with the option "Track
NTFS Alternate Data Streams and Hardlinks" activated.
Bugfix: It is now also possible to pass domains and servers like \\domain or \\server at the command line.
Previously this worked in the user interface but caused an error message at the command line.
Many further enhancements and a few minor bug fixes have been incorporated.

Changes in V5.1.2  (21 Jul 2008)
All lists now provide a new button in their toolbar that allows to save their contents to an Excel file.
Added possibility to export the tree map and the file ages chart in the "Schedule TreeSize Task" dialog.
Here a new function "Save to Batch File" has also been added to the context menu of the text field
containing the full command line.
Retrieving the file version of EXE, DLL and similar binary files no longer changes their last access date.
The context sensitive help via F1 key now also works correctly under Windows Vista.
File Search: It is now possible to search for files whose path is longer than a certain number of
characters.
This allows to find paths longer than 255 characters which make problems e.g. in the Windows Explorer.
File Search: A selected "Since" interval on the "Date" tab of the Custom File Search is now saved for the
next start and to XML files (File > Save Search Options). Previously it was only saved implicitly as lower
and upper border of the date interval.
Bugfix: The "Since" date intervals were not working as expected if the negated date filter "Not Changed",
"Not Access" or "Not Created" were selected.
Bugfix: The date picker controls of the Custom File Search did not always report the state of their
integrated checkbox correctly. This could lead to files missing in the search results.

Changes in V5.1.1  (10 Apr 2008)
TreeSize is now able to handle paths with more than 255 characters when searching or scanning the
disk.
TreeSize now applies NTFS compression and removes it from files that are marked as readonly.
The compatibility with 64Bit systems has been improved.
The treemap chart is drawn much faster now for large file system trees.
File Search: When saving a result list, now the visibility and order of the columns is taken into account.
File Search:  When  performing  a  move  operation  with  the  option  "Create  Shortcut  ..."  activated,  now a
description is  added to each  shortcut  that  contains  the  destination  path,  the  responsible  user  and  the
date of the move operation.
A few minor improvements and bug fixes have been incorporated

Changes in V5.1  (04 Mar 2008)
Many improvements for the new tree map:
- If a folder has no subfolders  and file extensions statistics  was activated during the scan,  the file types
are now shown as subitems in the tree map.
- Some graphical changes result in an improved appearance of the hierarchy.
- A legend for the colors has been added.
- It is now possible to zoom and scroll the chart in order to see more details.
Improvements in multithreading makes scans up to two times faster.
The Explorer context menu is now  available  as a  submenu in the  charts and  the  root  folder  of  a
scan.
When exporting the data to a file, the save dialog now has a checkbox that lets you decide whether or not
the file should be opened after saving.
When saving the extensions statistics  to a  text  file,  you  now have  a  checkbox  in  the  save  dialog  that
allows you to save the expanded groups only, just as you see it on the screen.
The users  and extensions statistics  now allow to  select  multiple  items,  which  is  useful  if  you  want  to
export / print them partially only.
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The context sensitive  help has been improved.  Pressing F1 should now always  lead  to  the  correct
chapter in the help file.
A new column has been added that  shows the error message if a folder  could  not  be  scanned.  This  is
useful  in  particular  for  scheduled  scan  that  export  their  results  to  an  Excel,  HTML  or  Text  File
(Professional Edition only)
If  the  Mixed  Mode  for  sizes  is  turned  on,  the  charts  will  now  also  use  an  appropriate  size  unit  for
displaying size values.
It is now possible to delete single values from the history chart using the right click menu.
Some other minor bug fixes and improvements have been incorporated.

File Search:
Added new  columns to  the  result  lists  that  show the  attributes of  the  files,  the  version  number  of
binary files, the permissions and the creation date.  Some of the new columns are by  default  turned off
and can be turned on using the "View" menu.
The "Move  To" dialog of the File Search now has an  option  to  create  shortcuts for  moved  files at
their original location that point to their new location.
Added possibility to search for files with NTFS alternate  data  streams in the custom file search (tab
"Attributes"). If this search is active and alternate data streams are found, their sizes are added to the file
size and in the column "Attributes" a "*" is added to the attributes. Checking for alternate data streams is
slow and requires read access to the files that should be checked.

Changes in V5.0  (23 Nov 2007)
It is now possible to group scans under a virtual root folder. This virtual root folder shows a summary of all
scans that  are part  of  this  group.  This  way  you  can  merge  different  scans  together  e.g.  for  printing  or
exporting.  You can access this  feature through the context  menu of a root  folder or through  the  "Tools"
menu.
A new kind of chart called treemap has been added. It shows a hierarchical view of the file system. In this
treemap chart each folder is shown as a rectangle with its subfolders inside, again as rectangles.
The  list  on  the  "Extensions"  tab  can  now be  grouped  by  file  types  like  "Audio  Files",  "Video  Files",
"System Files", etc. This feature can be turned on or off by a new toolbar button.
The tabs "Extensions",  "Users"  and "File Ages" now have a feature "List  Files"  that  generates  a  list  of
files of the selected item.
The selected items in the various file and directory lists of TreeSize now show the selection using a style
similar to Windows Vista. This makes colored text and the small embedded charts easier to read.
The  TreeSize  column  for  the  Windows  Explorer  is  now  also  supported  on  64Bit  systems.  The  .NET
Framework 2.0 is required on 64Bit systems for the column to work.  Unfortunately  a Microsoft  employee
confirmed that such an additional Explorer column won't be possible under Windows Vista.
The number of decimals can now be set in the View menu instead of the "Options" dialog.
The gradient colors of the optional indicator bars in the tree can now be chosen in the "Options" dialog.
In the Options dialog you can now change the maximum number  of  threads  that  TreeSize  Professional
creates  for  each  scan.  Like  before  TreeSize  Professional  will  still  adjust  the  number  of  threads  to  the
current system load and so often create less threads than the maximum number.
In the Options it  is  now possible to customize the intervals  that  are  used  to  generate  the  chart  on  the
"File Ages" tab.
TreeSize  Professional  has  a  new option  that  allows  taking  hard  links  and  alternate  data  streams  into
account  when  calculating  disk  space,  which  produces  more  accurate  results.  However  this  makes  it
necessary to open the files and therefore slows down a scan.
The "View" menu now allows switching to plain Byte values.
The Excel,  Text  and HTML export  options now allow to specify  whether or not  units  like  "KB",  "MB"  or
"%" should be added to exported values. By omitting units the thousands separators will  also be omitted,
which simplifies further processing of exported values. This replaces the former option File /  Export  /  Use
plain numbers.
The  command  line  options  /FILEAGESCHART and  /HISTORYCHART have  been  added.  They  allow  to
save the charts on the "History" and the "File Ages" chart.
The new command line option /TOPFILESLIST allows exporting the top 100 files list.

http://www.microsoft.com/downloads/details.aspx?familyid=10CC340B-F857-4A14-83F5-25634C3BF043&displaylang=en
http://www.microsoft.com/downloads/details.aspx?familyid=10CC340B-F857-4A14-83F5-25634C3BF043&displaylang=en
http://www.microsoft.com/downloads/details.aspx?familyid=10CC340B-F857-4A14-83F5-25634C3BF043&displaylang=en
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The columns of the "Copy list of files" feature are now determined by  the settings for the "Text  Export"  in
the "Options" dialog of TreeSize
The executable has been renamed to "TreeSize.exe".
The support for Windows 98 and ME has been dropped.  Registered customers  are still  able to download
the Windows 98/ME compatible TreeSize V4 from our customers area.
New application icon.

File Search:
An additional search type "Custom Search" has been added. This search type allows you to freely  define
and combine search criteria like file name, date, size, attributes and owner.  The results  can be printed or
exported like you are used from the other available search types.
Now entire servers, entire domains or even your entire network  can be searched.  TreeSize automatically
browses for PCs and all shares on them (including hidden shares) and performs the search on all  shares
that it finds.
Improved  multithreading  support,  especially  for  the  MD5  checksum  calculation,  which  should  produce
results faster on multi-core machines.
It is now possible to export and import the results as simple paths only (DIR /B /S format).  This  simplifies
post-processing of TreeSize results and allows to import lists of paths in TreeSize.
It is now possible to pass an XML file to the TreeSize File Search on the command line,  which contains
previously saved search options. This simplifies scheduled scans with predefined search options.
The Move operation now optionally logs the performed operations to a log file.
The result lists do now work as a source for drag and drop operations.
A new feature "Check all  but  Newest"  has been added to the context  menu of  the  duplicate  file  search
results.
A new feature in the context  menu of the duplicate file search allows to replace duplicate files  with hard
links. This way all the duplicate files remain at their position, but only one file occupies disk space.

Changes in V4.3.2:
On 64Bit Windows systems TreeSize now turns off file system redirection for its  threads.  The file system
redirection hides some system folders in the Windows directory from 32Bit processes.
Bugfix:  The TreeSize File Search Option "Exclude files  that  have changed in the past  XX hours"  did  not
consider the local time zone.
Bugfix: The Duplicate File Search with MD5 checksums did not include readonly files.

Changes in V4.3.1:
If the "Go to Parent Folder" button is hit  and the currently  selected folder is  the top node but  not  a drive,
TreeSize now asks if it should scan the parent folder.
Bugfix: Some of the initial values in Tools - Options - Columns/Export were wrong.
File Search: The "Save Result" function now asks if it should overwrite an existing file, or append to it.
File Search: The "Save List" feature now creates Unicode text files.
File Search:  For the duplicate file  search  the  comparison  of  the  content  of  large  files  with  and  without
MD5 checksum has been improved.
Bugfix:  The TreeSize File Search of the Personal edition did not  restore the selected paths  on  the  next
start
Some minor improvements have been incorporated.

Changes in V4.3:
A simple history function has been added to TreeSize.  Whenever a path is  scanned,  TreeSize saves the
size of this path (but not their subpaths) and displays the size development of this path or drive in a chart
on the new "History" tab.
XML Compare:  You can now also compare two different  directory  structures.  If the paths  do  not  match,
you will be asked if you want to proceed.
File Search: The duplicate file search now optionally compares files based on the MD5 checksum of their
content. This makes it possible to find true duplicate files that differ in their name or last change date. The
drawback is  that  the calculation of the MD5 checksum takes longer than the comparison of name, date
and size.
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File  Search:  The  right  click  menu  of  a  file  group  in  the  result  list  of  "Duplicate  Files"  now  offers  the
possibility to compare the files of a group byte by byte and remove those that are not equal.
File Search: All Options on the "View Options"  tab have been moved to the new "View" menu.  So these
options are available on all tabs now, without the need of changing to the old "View Options" tab.
File Search: For each item a long tooltip is now shown that contains detailed information on the file.
File Search: For folders matching $NTUninstall*$, that  are listed by  default  in temporary  file search,  their
folder size is shown now.
File Search:  These items have been added to the main menu:  Tools  /  Empty  Recycle Bin,  Help /  FAQ,
Help / Check for Update, Help / About.
File Search: A new option allows to include cookies with the Temporary Internet Files.
File Search: When files are moved, their path is new prefixed with their drive letter. This makes it easier to
restore the moved files again, if multiple drives have been searched.
Bugfix: The File Search sometimes mixed up file paths when moving files.
Bugfix:  Fixed error that  occurred under Windows  Vista  when  someone  logged  into  an  existing  session
using Remote Desktop with TreeSize already on the screen.

Changes in V4.2.2:
Bugfix: When displaying the results in the TreeSize File Search, occasionally an error message occurred.

Changes in V4.2.1:
Bugfix: Sometimes a non critical error occurred when a folder was deleted using the right click menu.
File Search: A check box was added to the Duplicate Files  search that  allows to control whether or not
the exclude filter should be used.
File Search: The exclude filter now accepts the wildcards '*' and '?'.
Bugfix:  The Duplicate Files  Search,  did sometimes leave out  some  duplicate  files.  Other  duplicate  files
were split into two groups because their time stamps were slightly different. 
XML import: The error handling and user aborting within the XML import has been improved.
Some other minor bug fixes and improvements have been incorporated.

Changes in V4.2:
In the Options dialog (Tools  /  Options /  Scan) you may now choose the priority  for the scan and search
threads. You may reduce their priority up to idle (use only  unused CPU time),  which allows you to run a
scan with TreeSize without any impact on your PC or server.
The toolbar of the Top 100 Files List now contains a Delete button.
The style sheet treesize.xsl for XML files has been revised:
- It now works under Windows Vista with Internet Explorer 7.
- Formatting and performance have been improved.
- Errors that occurred during the scan are now indicated by a small exclamation mark in front  of the folder
name.
If the option "Follow mount points  and symbolic  links"  is  turned on,  then TreeSize follows only  links  that
point outside the scanned directory tree. This prevents circular references and folders  from being counted
twice. The link target is now also shown in the long tooltip of the directory tree.
In the background of the directory  tree a gradient  now is  shown for each folder that  indicates  its  size  in
relation to the entire scanned file system tree.  We hope you will  like this  new visualization of  the  folder
size. If not, you may switch it off in the Options dialog.
The context menu of the file extensions and user statistics  now have a menu item that  allows to copy a
list of files of the selected file type / user to the clipboard.
The  user  statistics  now use  a  caching  mechanism  which  significantly  increases  the  performance  of  a
scan with the users statistics activated and also reduces the traffic to the Windows domain controllers.
The new command line option /UNITTYPE allows to set  the unit  (KB,  MB, GB) that  should  be  used  for
displaying size values. For detailed information please see the help file.
The  small  arrow  indicating  symbolic  links  and  reparse  points  is  now  also  shown  in  the  Details  list.
System and hidden folders are now shown "ghosted" like in the Windows Explorer.
The TreeSize File Search can now be started from the context menu of any folder in the directory tree.
File  Search:  A new search type allows you to search for  duplicate  files.  Currently  files  with  the  same
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name, size and change date will be listed. This feature will be further improved in the next release.
File Search: It is now possible to save and load the options of the File Search to/from an XML file.
File Search: The cache files of the Opera browser are now also found by the search type "Internet Files".
File Search:  The temporary  file search now has an option that  lists  all  files  in the "Recent"  folder of  the
user profile. This option is  turned on by  default.  Although Windows shows only  the last  15 entries  in the
"Recent  Documents"  folder,  it  keeps shortcuts  to all  files  ever  opened  in  the  "Recent"  folder  which  are
quite useless.
File Search: The size and the number of checked files is now displayed in the status bar.
File Search: The Save dialog now has an option to save all result lists  (instead of the active one only),  as
well as an option to save the checked files only.
File Search: The new command line option /MOVETO replaces /MOVETOZIP and allows,  in addition to a
ZIP file,  a  folder  path  or  the  Recycle  Bin  as  destination  to  which  the  files  will  be  moved.  For  detailed
information please see the help file.
File Search: If "Add To Exclude List"  is  selected from the context  menu,  all  matching search results  are
now immediately removed from the result lists.
File Search: In the View Options a new setting allows to adjust, if the compressed size or the normal size
should be displayed for compressed files.
The support for Windows NT4 has been dropped.

Changes in V4.1.1:
The menu item "Remove from TreeSize (temporarily)" is now also present in the context menu of the
Details list, which allows multiple items to be removed at the same time.
Errors that occurred during a scan are now saved in the XML-Reports for each folder.
If the selected node is deleted in the directory tree, the next or parent folder is now selected
automatically.
A new option on the "View" tab of the Options dialog allows you to decide that icons should be
determined based on the file extension only. This is much faster, especially on network drives, because
Window opens many files to see if there are any icons inside. By default this option is turned on.
The "File Ages" Chart can now be printed, copied or saved using the context menu or a new toolbar.
Under Windows Vista an additional start menu item is created that runs TreeSize as administrator.
A new item in the Tools menu allows you to start TreeSize again as Administrator under Windows XP and
Vista.
The File Search now uses the setting of the Options dialog "Follow mount points and symbolic links" from
the main module when recursing through the file system. It is recommended to keep this option turned off
under Windows Vista, because Vista makes excessive use of symbolic links, which produces a lot of
duplicate results.
The command line Switch /SEARCH:Start now by default checks all items in the result list of the File
Search.
Some other minor bug fixes and improvements have been incorporated.

Changes in V4.1:
Multithreaded scanning has been improved which makes especially network scans up to two times
faster. 
A new tab "File Ages" has been added to the right pane. It shows the distribution of the file ages for each
directory.
The Extensions, Users and Top 100 lists as well as the result list of the File Search now have a right
click menu for their column headers which allows to show or hide individual columns. Columns can be
rearranged using drag&drop. These settings are saved when TreeSize is closed and are restored on the
next start.
The list of file types on the tab "Extensions" now fills up faster.
The Details tab now also has a toolbar. It can be turned off using the Toolbar submenu in the View menu.
Folders that could not be scanned due to an error are now shown with a small exclamation mark in the
directory tree. The error message is added to the tooltip of this folder.
A new option allows to decide if date and time should be shown for the last access, last modified and the



What's New 17

TreeSize Professional - What's New

creation date, or only the date.
The Tools menu now has a menu item that opens the configuration dialog for the Windows System
Restore. The Windows System Restore by default uses 10-15% of every hard disk drive. A good source
for freeing disk space is the reduction of this space reserved for the System Restore.
The unit and the decimals of the TreeSize column for the Windows Explorer can now be configured in the
Options of TreeSize Pro on the new tab "Shell Extensions". Furthermore the Explorer extension can now
be fully turned off here.
The context menu item "Find deepest nesting" is now not only available in the context menu of the root
folder but also in the context menu of the sub-folders.
The drive panel now uses a different color to show the free space as the Details view uses in the column
"% of Parent".
It is now possible to copy the content of the drive panel to the clipboard in a CSV-compatible format.
TreeSize is now compatible with Windows Vista. The Vista Explorer however lacks the interface for
extending it with additional columns, so the TreeSize column is currently not available for the Windows
Vista Explorer.
File Search: The right-click menu now allows applying the NTFS compression to the selected files in a
result list.
File Search: The visibility of columns in the result lists can now be adjusted on the View Options tab.
File Search: Compressed files are now shown in a different color, just like in the main application. For
compressed files, their compressed size is now shown instead of the uncompressed size.
File Search: The result list of the temporary file search now shows the reason why a file or folder was
added to the list (e.g. the matching pattern, because it is a link with an invalid target etc.)
File Search: Drives removed from the drive list window now stay excluded when the application is started
the next time.
Bugfix: The selected item of the tree in the main windows was not always drawn correctly.
Bugfix: The File search module sometimes overwrote settings of the main module if both modules were
running and the File Search module was terminated after the main module.
Bugfix: Removing a currently scanned folder temporarily from TreeSize  occasionally resulted in an error.

Changes in V4.0.2:
The Scan Include and Exclude patterns (View > Options > Include/Exclude) are now also Unicode
enabled.
Bugfix: Loading XML Reports that contained foreign language characters occasionally caused errors.
Bugfix: A combination of the two command line parameters /OPEN and /EXCEL did only open the XML
file, but did not start the Excel export.
Bugfix: Double clicking on a file in the chart now opens the file also in a folder with no sub-folders.
Several minor bug fixes and improvements have been incorporated.

Changes in V4.0.1:
Bugfix:  Adding  an  UNC  Path  to  the  list  of  drives  in  the  TreeSize  File  Search  failed  with  an  error
messages.
Bugfix: Toggling the sort order for the first column in the extensions and users list didn't work.
Bugfix: Opening certain XML reports failed with an error due to an internal overflow.
Some minor bugfixes and improvements have been incorporated. 

Changes in V4.0:
TreeSize now scans a file system branch with multiple threads. The number of threads that are used is
adjusted automatically dependant on the system load. Because of the latency of hard disks and network
drives, this new feature drastically reduces the time necessary for scanning a file system branch.
In the new dialog "Schedule Tasks" (Tools / Schedule Tasks) you can now add customized TreeSize
Tasks to the Windows Scheduled Tasks.
The XML import, export and compare have been improved. All XML operations are much faster now and
use considerably less memory. The size of the XML-files has been reduced as well.
The tree control was replaced with a faster one, which increases the performance of a scan and expand
operations in the file system tree.
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The tree now shows large hint windows that include detailed information about each node. This feature
can be turned in the Options.
Most parts of TreeSize are now Unicode enabled under Windows NT/2000/XP/2003. Windows 98/ME are
still supported, but with limited Unicode capabilities.
The Options dialog now has a check box, that let's you decide, whether or not TreeSize should appear in
the Explorer context menu of Folders for the current user.
A new drive list box in the bottom left corner provides a quick information about the size and the free
space of the local drives. Additional remote drives can be added using the context menu. Double clicking
on a file starts a scan in TreeSize.
The top 100 largest files of the scanned path are now shown on an additional tab on the right pane.
Added support for file system Drag&Drop operations in the main window of TreeSize.
The HTML export is now UTF8-encoded and exports Unicode folder names correctly.
The extensions statistics now shows the Windows description and the corresponding icon for each file
type.
In the Options you can now define what TreeSize should do when it starts without a path to scan. It may
scan a list of fix paths, it may scan the paths that were active the last time it was used, or it may simply
do nothing, which is the default behaviour.
Two new columns have been added that show the MS Office author and the MS Office last change date.
These values get extracted from all MS Office files.
The context menu of the tree now allows to create a new folder. The shortcut for this operation is Ctrl+N.
All percent values do now have a bar chart beneath them that indicates the percent value.
It is now possible to compress and decompress files and entire folders with NTFS compression using
the context menu of TreeSize. The values inside TreeSize will be updated on-the-fly.
A style sheet can now be used with exported HTML files. The style sheet file can be specified under
View / Options / Export / HTML.
The width of the columns in the printed reports can now be adjusted under View / Options / Columns /
Printed Report.
A scan that has been opened and compared through command line options, can now again be exported
through a command line option like /XML or /EXCEL.
A new menu item in the Help menu allows to check, if a newer version of TreeSize is available.  
Several minor improvements have been added as well.

  
File Search:

The TreeSize File Search now uses multiple threads per drive which reduces the time that is needed for
scanning a drive. 
The list controls have been replaced with faster ones, which reduces the time needed during the scan as
well as the time needed for move operations especially for a large number of results.
The selected items in a list can now be copied to the clipboard using the context menu.
The TreeSize File search does now fully support Unicode file and folder names. The speed and reliability
of the "Move To" feature has been significantly improved.
The Move-To-Zip feature and the "Save Results" button now have a progress indicator.
The querying of the file owners can now be turned off in the View Options if not needed. Querying the file
owner is a slow operation under Windows.

5 Tips & Annotations

Especially scans of larger network drives may take a long time. With the Professional Edition
you may perform  such scans  overnight  using  Scheduled Scans and save the results  to  a
XML file which can be loaded again later.

The last access date is the day when a file was used the last time; e.g. when a program was
executed, a DLL was loaded or a bitmap was shown the last  time.  So if  a  file  has  not  been
accessed for  a  long time,  it  may probably not  be  needed  on  your  system.  This  is  a  great
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possibility to recognize and remove unused files  from  your  Windows  and System  directory.
The last access date that TreeSize Professional shows for a folder  is  the latest  last  access
date of all files in the folder's directory branch.

Use the TreeSize File Search to find obsolete files on your hard drives. 

In the main windows TreeSize Professional supports drag&drop file system operations.

All folders that are visible in the directory tree on the left will also appear in the printed report or
the exported file. Alternatively, you can set in the Options of TreeSize Professional  to  always
print or export all folders of the current directory tree.

The Filter and User defined cluster size settings in the Options are not saved in order to avoid
wrong values when using TreeSize Professional the next time.

You can use the CD-ROM view to determine how much space a directory tree would occupy
on a CD or DVD. 

You can use wildcards in the paths to scan and so even scan paths like "S:\Users\R*" or "R:
\*\MyVideos".

You can scan all shared drives in a domain by entering the domain name in the drive combo
box.

 TreeSize Professional  ships  with  an XSLT file  that  formats  the data inside the XML file  for
output in a browser that supports XSLT processing.

For  continuous  analyzing  of  disk  usage  on  large  servers  we  recommend  our  product
SpaceObServer.  It  collects  the data using a background system  service and stores  it  in  a
SQL database. It uses less RAM than TreeSize Professional, and the reporting capabilities are
more flexible because it  is  built  on a database.  More information is  available  at   http://www.
jam-software.com/spaceobserver/

http://www.jam-software.com/spaceobserver/
http://www.jam-software.com/spaceobserver/
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6 TreeSize Column for Explorer

TreeSize  Professional   ships  with  a  shell  extension  that  adds  an  additional  column  to  the
Windows  Explorer.  It  shows  the  size  not  only  for  files  but  also  for  folders.  This  feature  is
intended for a quick overview. The new column can be activated using Choose Columns/Details
in the View menu of the Windows Explorer or through the context menu of the column headers
of the Windows Explorer. If you would like to enable this column in the Windows Explorer for all
folders, then you have to configure this in the Folder Options of the Windows Explorer using the
button Apply to All Folders. This column requires  Windows  XP/2003 and can be configured or
fully turned off  in  the Options  dialog.  On 64Bit  Windows  systems,  the  .Net  framework  2.0  or
higher is required.

Unfortunately it is not possible to provide such an extension for the Explorer of Windows Vista or
higher,  because  Microsoft  has  removed  the  used  interface  from  this  version  of  Windows.
Microsoft has officially confirmed that a similar  extension of  the Explorer  is  not  possible  under
Windows Vista or higher.

Note:  You have to  choose Install  TreeSize column for  Windows  Explorer  within  the  TreeSize
Installation. Otherwise the TreeSize column will not be available.

7 Wasted Space

The wasted space is the amount of space in clusters on your hard disk that are not entirely filled.
Keep the following formula in  mind:  size +  wasted space =  allocated  space.  The  file  system
FAT32 may have very large cluster sizes, depending on the partition size.



Wasted Space 21

TreeSize Professional - Wasted Space

FAT32
Partition Size Default Cluster Size

01 - 08 GB 4 KB
08 - 16 GB 8 KB
16 - 32 GB 16 KB

>32 GB 32 KB

If you have for example a single FAT32 partition on a 32GB hard disk, you have a cluster size of
32KB on it. If you store 10 files of 1 KB on this partition, this would use 10*32KB=320KB of your
hard disk space, and 320KB - 10KB = 310KB would be wasted.  Especially a  huge number  of
small files significantly increases the amount of wasted space on FAT partitions.

To reduce the wasted space, there are the following possibilities: 

Avoid using the FAT32 file system on partitions larger than 16GB.

Windows  2000 and  later  versions  provide  the  possibility  to  format  your  hard  disk  with  the
NTFS file system. It usually operates with 512 - 4096 Byte clusters and has the best storage
efficiency  of  all  Windows  file  systems.  Furthermore  NTFS  is  able  to  compress  selected
directory branches. NTFS partitions  cannot  be accessed from  Windows  9x or  DOS without
use of 3rd party software. 

8 Notes on NTFS

The file  system  NTFS can be used with  the operating system  Windows  NT or  later.  It  offers
some  special  features  which  also  have  effects  for  TreeSize  Professional.  We  will  describe
some of these features and their impacts on this software in the following paragraphs.

Access Control Lists

A user under Windows NT or later is able to restrict  the way other  users  can access  his  files
and folders.  He  can  grant  or  deny  other  users  or  groups  certain  rights  like  reading,  writing,
executing or deleting files. That way a user may even deny the administrator to access his files
and folders. If  an administrator  tries  to  access  a folder  in  the Windows  Explorer  to  which the
owner  denied  any  other  users  reading  access,  an  "Access  Denied"  error  message  will  be
displayed. However, TreeSize Professional is  able to scan such folders, if you are logged in as
administrator or as a user that has the right to perform backups (This option can be changed at
"Control  Panel"  /  "Administrative  Tools"  /  "Local  Security  Policy"  and  with  the  user  editor  of
Windows).

File Based Compression

NTFS supports compression on an individual file basis. Files that are compressed on an NTFS
volume  can  be  read  and  written  without  first  being  decompressed  by  another  program.
Decompression happens  automatically during the reading  of  the  file.  The  file  is  compressed
again when it is closed or explicitly saved. 

The space occupied by a compressed file  is  usually much smaller  than its  normal  size.  As  a
consequence,  for  folders  that  are  partially  or  completely  compressed,  the  allocated  space
reported  by  TreeSize  Professional  may  be  smaller  than  the  size  reported  for  this  folder.
TreeSize Professional is able to show the compression ratio in an extra column on the "Details"
tab. Additionally it  can show  compressed files  and folders  in  a  different  color.  These features
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can be turned on in the Options dialog.

TreeSize Professional is  able to compress and decompress entire file system  branches  using
the context menu.

The NTFS version that comes with Windows 2000 and later supports an additional concept that
is  similar  to  compressed files:  sparse files.  Files  which  are  large  but  only  partially  used  are
called sparse files. Because the operating system does not allocate disk space for the unused
parts of a sparse file, it occupies less disk space than its actual size is. TreeSize Professional
treats sparse files like compressed files and also calculates the compression ratio for them.

Reparse Points: Volume Mount Points and Symbolic Links

Since Windows 2000 NTFS supports volume mount points and symbolic links. A volume mount
point is  an existing path where you "mount" another volume. Given this, users and applications
can refer to the mounted volume by that path. It allows you to  unify disparate file  systems  into
one logical file system. Symbolic links work similar: If you for example have an empty folder "C:
\Documents\Images", you can create a symbolic link to "E:\Pics" in it. Applications will then see
the content of "E:\Pics" in "C:\Documents\Images".

If the Option "Follow Mount Points and Symbolic Links" is turned on, TreeSize Professional will
include the contents of these folders when scanning. Since they are not physically stored on the
drive you are scanning, this may produce irritating results.

Alternate Data Streams (ADS)

In  NTFS,  a file  consists  of  different  data streams.  One stream  holds  the  security  information
(access  rights  and such things),  another  one holds  the "real  data"  you expect  to  be in  a  file.
There may be alternate data streams,  holding data the  same  way  the  standard  data  stream
does. These alternate data streams are hidden. That means that you can have a file with 1 byte
in the official main data stream and some hundred MB in one or  more alternate data streams.
The dir command, file managers or windows explorer will show 1 byte as the size of this file, but
it actually allocates more space on your hard drive.

TreeSize Professional can detect alternate data streams and add their sizes to the allocated file
size. 
Note: ADS stores information in the same cluster as the main data stream, so if a file has one or
more ADS, this file does not necessarily allocate more disk space.

You can choose to  detect  alternate data streams,  to  get  a  more accurate allocated space of
directory branches,  in  the  Options  Dialog.You  can  search  for  Files  containing  alternate  data
streams using the Custom File Search of TreeSize Professional.

Hard Links

In  a  Windows  environment  a  hard link is  a  reference,  or  pointer,  to  physical  data on a  NTFS
storage volume.  All  named files  are hard links.  The name associated with  the file  is  simply a
label  that  refers  the operating system  to  the  actual  data.  On  NTFS  volumes  more  than  one
name can be associated with the same data.  Though called by different  names,  any changes
made will affect the actual data, regardless of how the file is called at a later time. Hard links can
only refer to data that exists on the same file system. The data is accessible as long as at least
one link that  points  to  it  exists.  When the last  link is  removed,  the  space  is  considered  free.
Please note that all hard link pointing to the same file share also the same Security Description
(access permissions).
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If more than one hard link points to a  file's  data,  the space allocated by these files  is  just  one
time the file size (not including the space of the file master table), no matter how many hard links
exists TreeSize Professional is  able to detect the number of hard links pointing to one file  data
and takes that value into account when calculating the allocated space of directory branches.

You  can  choose  to  detect  hard  links,  to  get  a  more  accurate  allocated  space  of  directory
branches, in the Options Dialog.

The TreeSize FileSearch uses the hard link mechanism  of  NTFS storage volumes  to  remove
redundant file content of duplicate files. Use the "Deduplicate" function to remove duplicate files
by hard links. This will reduce the allocated space of your hard disk.

9 Printing

TreeSize Professional has flexible printing functions:

You may print a detailed report by selecting "Print Report"  from the "File"  menu or  by pressing
the "Print" button in the toolbar. The report will show the directory structure of the current folder
including directory lines and the information you have chosen in the Options. There you can also
decide if the whole directory tree should be printed, or just those parts that are expanded in the
TreeSize Professional window. This way you are able to choose the folders that will be included
in the printed report. 

If the "Details" tab is active in the right pane of the TreeSize Professional main window, you can
print  the contents  of  the folder  which is  currently selected by  using  "Print  Folder  Contents..."
from  the "File"  menu.  You will  see all  files  and direct  sub-folders  in  the printout,  including the
icons and the other information. If you want a listing of all files in the scanned folder or drive, you
can copy a list  of  all  files  to  the clipboard and paste it  into  your  favorite  spreadsheet  or  word
processor by selecting "Export List of Files" from  the "File"  >  "Export"  menu (not  supported in
the Personal Edition). If a  chart  is  visible  in  the in  the right  pane of  the TreeSize Professional
window, you can print the current chart by selecting "Print Chart" from the "File" menu.

You can open the "Page Setup" dialog to adjust the margins for  printing.  Use the "Print  Setup"
dialog to choose a printer. Both dialogs can be accessed from the "File" menu.

10 FAQ

General / Registration

Main Program

Printing / Export

File Search

10.1 General / Registration

Q:Which operating system does TreeSize  Professional  run  on?  What  are  the  system
requirements?

A: Currently  the  following  operating  systems  are  supported:  Windows  XP,  Windows  2003
Server, Windows Vista, Windows Server 2008,  Windows  7 in  both their  32 Bit  and 64 Bit
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editions.  The  operating  system  should  have  installed  the  latest  patches.  There  are  no
additional  system  requirements.  The  Personal  Edition  does  not  run  on  Windows  server
systems!

Q:Does the setup copy any files to the Windows directory?
A: No, all files of  TreeSize Professional  are copied to  the selected installation path.  The main

executable file is even able to run without installation.

Q:Does TreeSize Professional support Unicode?
A: Yes, all parts of TreeSize Professional support Unicode enabled.

Q: Is TreeSize Professional able to delete readonly files?
A: If you start TreeSize Professional with administrative privileges, it will also try to delete write

protected  files  when  you  are  removing  them  from  disk.  In  case  this  is  not  possible,  e.g.
because the file  is  locked by another  application,  this  file  will  be  marked  for  deletion.  This
means, Windows should delete the file on the next system restart. Please note that there is a
difference between moving files  to  the recycle  bin  (shortcut  "Del")  and removing files  from
disk (shortcut "Shift" +"Del").

Q:How can I order TreeSize Professional? What does ... cost?
A: For questions regarding prices please have a look at our price list and our ordering FAQ.

Q:What is the difference between the Professional and the Personal Edition?
A: The Personal Edition has the same features as the Professional Edition, except that it  does

not  support  network  drives,  Windows  Server  systems,  command  line  options  and  data
export.
Since V5.4 the Personal edition scans network drives if the computer it runs on is not part of
a  Windows  domain  and  the  remote  system  is  not  a  Windows  server.  This  enables
customers of  the Personal  Edition to  scan network drives  in  their  home network,  including
NAS systems based on Linux and Samba 3.

Q:What is the difference between the evaluation copy and the  full  version? Will  there
be additional features?

A: The evaluation copy allows you to test the software before you buy it. The maximum time to
do this is 30 days. Further usage of the software after this period is not permitted and violates
the law.  In  order  to  allow  our  customers  to  fully  test  our  software products,  our  evaluation
versions usually do not contain significant limitations. But the software may remind you from
time to time that you should purchase the software after your testing is finished.

Q: I just purchased your product. How can I now activate my trial version?
A: You have to download the full version of the software from our customer's area at http://www.

jam-software.com/customers/.  The  login  data  can  be  found  in  the  email  or  in  the  printed
license which you have received after the purchase. In case that you do not have your  login
data any more, you can request them to be sent to the email address that you have used for
purchasing the software.

Q:Why don't you use activation codes that turn the trial version into a full version?
A: We do not work with activation codes because you can find them very easily on the internet.

We  are  working  with  separate  trial  and  full  versions.  After  purchasing  our  software,
customers get an account for our customer's area where they can download the full version
for at least 12 months. We will also send a CD  at  additional  cost.  Our  customers  will  also
receive an installation key, which will be necessary to install the full version. You should keep
both in a safe place. Installing the full version over the trial version will preserve your existing

http://www.jam-software.de/customers/prices.php#101
http://www.jam-software.de/customers/prices.php#101
http://www.jam-software.de/customers/help.php
http://www.jam-software.de/customers/help.php
http://www.jam-software.com/customers/
http://www.jam-software.com/customers/
http://www.jam-software.com/customers/
http://www.jam-software.com/customers/
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data and settings.

Q:How do I upgrade to the latest version?
A: In the "Help"  menu  you  can  use  "Check  for  update"  to  check  online  if  there  are  updates

available.  Within  your  maintenance  you  can  download  the  latest  version  of  TreeSize
Professional from our customer's area. The login details for our customer's area have been
emailed to you after the purchase ad are printed on the license document. To upgrade older
versions just run the installation file. Your user settings will still be available after the upgrade.

Q:Although I  have  purchased the  full  version of  your  software  product,  it  still  shows
"UNREGISTERED" in the window title. Why?

A: There are 3 possible reasons why "UNREGISTERED" still shows up:
1. You did not download and install the full version from our customer's area
2.  You  have  accidentally  installed  the  trial  version  again.  (Have  you  been  asked  for  an
installation key?)
3. You have installed the full version to a different folder than the trial version which is now still
on your disk.

Q: Is one user license sufficient if the software is installed on one computer though two
or three users may access the software?

A: Basically  you  need  as  many  licenses  as  you  have  PCs  on  which  our  software  is
available for execution. If these three users work on the same PC at different times,
then  one  license  is  sufficient.  If  they  work  on  three  different  PCs  and  start  the
software there, then you will need three licenses.

Q:Can  I  scan  my  Linux/Unix  servers  or  my  Linux  based  NAS  with  TreeSize
Professional?

A: If Samba is installed running on the Linux / UNIX system, then our tools can access a share
on this system using its UNC name, e.g. \\ComputerName\ShareName. If the file system on
the Linux /  UNIX system  is  accessible  through  NFS,  then  it  can  be  accessed  if  the  NFS
support for Windows is installed. For Windows XP/2003 please install the Windows Services
for UNIX, which include an NFS client. For Windows 7 (Professional and Ultimate) please go
to the Control  Panel  and activate the "Services  for  NFS" under  "Programs  and Features  >
Turn Windows Features on or off". Then you can mount an NFS share to a drive letter using
this command:
mount \\ComputerName\ShareName N:

It  might  be  necessary  that  you  create  the  following  registry  values  if  you  have  trouble
connecting the NFS drive:
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\ClientForNFS\CurrentVersion\Default\AnonymousUid

 as DWORD with the decimal value 10011.
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\ClientForNFS\CurrentVersion\Default\AnonymousGid

 as DWORD with the decimal value 10012.
All this applies to the Professional edition only.

10.2 Main Program

Q:Why is the allocated space that Windows shows in the properties dialog of the  drive
larger than the allocated space reported by TreeSize Professional?

A: The Windows  Explorer  and the TreeSize Professional  drive list  do show  the space that  is
physically  allocated  on  the  drive  while  TreeSize  Professional  shows  the  space  that  is
occupied by all files  under a certain path. Please make sure that you have the view  option "

http://www.jam-software.com/customers/
http://www.jam-software.com/customers/
http://www.jam-software.com/customers/
http://www.jam-software.com/customers/
http://www.samba.org/
http://en.wikipedia.org/wiki/Network_File_System_%28protocol%29
http://www.jam-software.com/redirects/?WindowsServicesForUNIX
http://www.jam-software.com/redirects/?WindowsServicesForUNIX
http://www.jam-software.com/redirects/?WindowsServicesForUNIX
http://www.jam-software.com/redirects/?WindowsServicesForUNIX
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Allocated Space" activated when you are interested in the physically allocated space. 
A possibility  is  that  not  all  parts  of  the drive could be scanned due  to  access  restrictions.
Therefore it is  highly recommended to run TreeSize Professional  as  administrator.  Turn on
"View  >  Options  >  Show  Errors  Messages"  to  get  notified  if  a  folder  cannot  be  scanned.
Turning on the Option "Track  NTFS Alternate Data Streams  and NTFS Hard Links"  in  the
Options dialog may result  in  more accurate results  but  slows  down scans.  If  a  drive letter
points to a sub-folder of a network drive, the allocated space (correctly) reported by TreeSize
Professional  may also be much  smaller  than  the  physically  allocated  space  on  this  drive
reported  by  the  Windows  Explorer  because  possibly  the  whole  drive  is  not  accessible
through the network. 
Beyond the space that is needed for storing the files itself, additional space is used for storing
management data like the File Allocation Table of the file system or the boot sector. It is  not
possible to free this space with TreeSize Professional or any other tool. This is usually 0.5 -
2% of the occupied space.  Another  possibility  is  that  you are using a Software RAID  -  like
Windows offers it - which spreads the data with redundancy over several disks. These disks
will appear as one logical volume and the failure of a single disk will not cause any data loss.
But for storing the redundant information additional space is needed. 
On Thinkpad laptops the Rescue&Recovery feature may use a lot of disk space in the folder
"RRBackup" which is not accessible to other applications.

Q:Are there any limitations on the amount of data that TreeSize Professional can query
at one time?

A: There are no explicit  limitations  in  what  TreeSize  Professional  is  able  to  scan.  The  more
folders and files the file system tree has that you want to scan, the more free memory will be
necessary to store the queried data. You can reduce the memory consumption by turning off
the user  statistics,  the file  extensions  statistics  and/or  the file  age statistics  in  the Options
dialog. For large server our product  SpaceObServer  may be suitable  as  well,  which stores
the collected data in a database on file level.

Q:Why do all  files on my disk have  the  same  last  access date  which  is  not  far  in  the
past?

A: The date values  in  the file  system  are maintained by Windows.  Windows  updates  the last
access date of a file each time when an application accesses or reads  a file.  Many backup
and virus tools access  every file  on your  hard disk regularly without  restoring the prior  last
access date.

Q:Why  doesn't  TreeSize  Professional  include  my  disk  into  its  calculation,  which  is
mapped to a directory using the Disk Manager of Windows?

A: By changing the option "Follow mount points and symbolic links" in the Options  of  TreeSize
Professional, you can control if mount points and symbolic links should be followed or if they
should be excluded from the calculations.

Q:What is the easiest way to scan all drives of a remote server?
A: TreeSize Professional accepts wildcards in paths, simply tell TreeSize Professional to scan \

\Server\?$ in the folder combo on the top left or at the command line.

Q:Scanning  a  server  disk  via  network  is  very  slow.  Is  it  possible  to  speed  up  this
process?

A: Scanning a drive via network is normally much slower than scanning a local disk because the
speed of  the network is  much lower  than the speed of  your  hard  disk.  Additionally,  server
drives are usually much bigger and contain more files than local hard disks. But you can use
the Command Line Options to perform your scans overnight. Network drives and command
line options are supported by the Professional Edition only. 

http://www.jam-software.com/spaceobserver/
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For  continuous  analyzing  of  disk  usage  on  large  servers  we  recommend  our  product
SpaceObServer.  It  collects  the data using a background system  service and stores  it  in  a
SQL database. It uses less RAM than TreeSize Professional,  and the reporting capabilities
are more flexible  because it  is  built  on a database.  More information is  available  at   http://
www.jam-software.com/spaceobserver/

Q: Is it  possible  to  have  the  program ignore  folders  that  are  less  than  a  certain  size
when displaying them in the tree?

A: In the context menu of the topmost folder you may choose to remove folders below a certain
size. To achieve this, right-click on the topmost icon (or use the "Expand" submenu of the "
Branch" menu), select "Expand" and then "Remove Folder <XX MB".

Q: Is it possible to add the free space to the bar chart?
A: The free space is added to the pie chart if TreeSize Professional is  in the "Allocated Space"

mode and the root of the scanned drive is selected. In other situations (e.g. if a sub-folder is
selected or the "Wasted Space" mode is active), it doesn't make sense to add the free space
because the relationship between the free space and the other values displayed is wrong.

Q:Can I scan network drives and hidden shares like"  \\Server\C$"  without  connecting
them to a drive letter?

A: Yes,  in  the Professional  Edition you can use UNC  names  like  "\\SERVERNAME\Share"  to
access  a network drive by  entering  them  in  the  drive  combo  box  on  the  top  of  the  main
window. You can also use UNC names on the command line.

Q: I  would  like  to  save  a set  of  drives and folders  that  are  scanned  each  time  I  start
TreeSize Professional. How can I do that?

A: You can specify the startup behaviour of TreeSize Professional in the Options dialog. Or you
can simply create a shortcut  to  treesize.exe on your  desktop or  Start  Menu and add those
drives and folders to the command line, separated with a space character.

Q:How can I limit a scan to just one user's files?
A: Please  make  sure  that  the  option  "Create  Statistics  on  File  Owners"  is  activated  in  the

Options of TreeSize Professional. After the scan is finished please right-click on this user on
the "Users" tab and choose "Limit to this user" from the context menu. You may also use the
Custom File Search to search files of certain users.

Q:On  a  Novell  Netware  volume,  TreeSize  Professional  reports  compressed  files  as
uncompressed and the user names are missing in the Owner columns. Why?

A: Unfortunately the Netware client for Windows does not supply information about compression
and file  owners  through standard Windows  API functions.  So developers  have to  integrate
special support for Netware in their applications. We may address this issue in a later version
of  TreeSize Professional,  but  so far  we do not  actively support  Netware.  All  other  parts  of
 TreeSize Professional work fine with Netware volumes.

Q: Is it possible to perform a silent installation of this software?
A: Starting  the  setup  with  the  command  line  parameters  /SILENT  /SUPPRESSMSGBOXES  /

PASSWORD=YourInstallKey   will  perform  a  silent  and  automatic  installation  with  the  default
settings. Please replace  YourInstallKey  with the installation key that you received after your
registration. Using /VERYSILENT instead of /SILENT will prevent any visual feedback. The option
 /DIR="x:\dirname" can be used to override the default install path.

Q: Is it possible to search for file extensions with TreeSize Professional?
A: You can for example apply a filter for a scan in the Options by adding patterns like *.bmp to

http://www.jam-software.com/spaceobserver/
http://www.jam-software.com/spaceobserver/


TreeSize Professional28

TreeSize Professional - FAQ

the  edit  field.  A  second  possibility  is  to  enable  the  "Create  Statistics  on  File  Extensions"
feature in the Options. This will provide a detailed statistics for the file types in each sub-tree
on the "Extensions" tab and you will be able to limit the values in the directory tree to one file
type.  A  third  possibility  is  to  use  the  Custom  File  Search  of  the  File  Search  Module  of
TreeSize  Professional.  Our  product  SpaceObServer  has  extended  and  more  flexible
reporting features if needed.

Q:The  wasted  space  shown  by TreeSize  Professional  is  extremely  high.  How  can  I
reduce the wasted space?

A: Most likely you are using the FAT32 file system which usually produces a lot of wasted space
due to  its  large  cluster  size.  Please  read  the  chapter  "Wasted  Space"  in  the  help  file  to
understand what wasted space is and to learn how to reduce it.

Q:The  folder  "System Volume  Information"  in  the  root  of  my drive  uses  a  lot  of  disk
space. What is the purpose of this folder? 

A: This  folder  is  part  of  the Windows  System  Restore.  You  shouldn't  delete  any  files  in  this
folder manually. Its size can be reduced by changing the appropriate  setting in  the System
applet  of  the  Windows  Control  Panel.  Windows  Vista  only  allows  to  turn  off  the  System
Restore  here.  The  space  used  by  this  service  can  only  be  reduced  using  the  Windows
command line utility vssadmin.

Q:When I run TreeSize Professional on one of our PCs, a blue-screen occurs / the  PC
reboots. Why?

A: A normal Windows application like TreeSize Professional  cannot  cause a blue-screen or  a
hard reboot,  only device drives  and central  parts  of  the  operating  system  can  cause  this.
Most likely something with this system is not OK and TreeSize Professional just triggers the
real cause for the problem. This can happen because TreeSize Professional accesses parts
of the harddisk that are not  accessed during normal  operation or  because of  the additional
load that a TreeSize Professional scan puts on the machine.

Q:Can TreeSize Professional be installed on a cluster?
A: Yes, TreeSize Professional can be installed on a cluster. It is not cluster aware, but does not

need to  be.  If  you obtain  a license for  each server  and install  TreeSize Professional  on all
machines of the cluster,  then you will  have TreeSize Professional  available  at  any time on
any server of the cluster.

Q:Are there any known problems when using  TreeSize Professional on a Citrix server?
A: TreeSize Professional runs in a Citrix environment. But on startup of TreeSize Professional it

is may not be visible on the taskbar. If you minimize the application, you can't find it no more.
This is a common problem of Citrix server. You can fix it by adding the following keys to your
registry:
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Citrix\wf
shell\TWI]
"DllName"="seamls20.dll"
"NotifyEvent"="WfshellTwiNotify"
"SeamlessFlags"=dword:00000040

[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Citrix\wf
shell\TWI\TMainForm.UnicodeClass]
"ClassName"="TMainForm.UnicodeClass"
"Type"=dword:00000041

Q:Where does TreeSize Professional store the data shown on the "History" tab?

http://www.jam-software.com/spaceobserver/
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A: This  data  is  stored  in  the  file  named  ScanHistory.xml  which  is  stored  in  you  user  profile
directory under Application Data\JAM Software\TreeSize Professional,

Q: If I scan network shares under Windows Vista, I get the error message that the access
to certain folders is denied, although I am a domain administrator. What can I do?

A: TreeSize Professional uses a special mechanism of Windows to get file listings of folders to
that you actually do not have read access. The same applies if you scan network shares and
belong to the group of domain administrators. Windows Vista Service Pack 1 has a bug
confirmed by Microsoft that prevents this mechanism from working on network drives.
Installing the Hotfix KB950790 for Windows Vista will fix this problem. This Hotfix is included
in the Windows Vista Service Pack 2.

Q:TreeSize  Professional  shows incorrect  number  of  hard  links  for  files,  stored  on  a
network share. What can I do?

A: Since  Windows 2008 Server  and  Windows  Vista  Microsoft  uses  "Client  Caches"  in
order to speed up the queries about gathering file  and directory meta information on
network drives. This approach helps also to utilize  the  available  network bandwidth
more  efficient.  However,  these  caches do always return  an  incorrect  value  for  the
NTFS hard links (always shown as "1").
The responsible caches can be disabled by the following steps:
1. Run "regedit.exe".
2.  Open  the  path
"HKEY_LOCAL_MACHINE\System\CurrentControlSet\services\Lanmanworkstation\Paramet
ers".
3.  Choose  "New  >  DWORD  value"  in  the  right  click  menu  and  set  the  name  to
"FileInfoCacheLifetime" and the value to "0".
After  these  steps  TreeSize  Professional  should  work  properly  with  hard  links.  For  further
information about the subject  please visit  http://technet.microsoft.com/en-us/library/ff686200
(WS.10).aspx
Note: In case a file has been recently opened, the number of hard links will still be shown as
1. After a few seconds the value will be shown correctly again.

10.3 Printing / Export

Q:How  can  I  specify  the  columns  that  should  be  included  in  the  printed  report  /
exported Excel file?

A: Under  "View  >  Options  >  Columns"  you may choose the included columns  after  selecting
one of the export options in the pull down box on top of the window. They will also be used for
scheduled scans as long as they are started under the same user account..

Q:How can I generate a list of files that belong to a certain user?
A: Please  make  sure  in  the  Options  of  the  "Scan"  tab  that  statistical  data  for  the  users  is

collected. Scan the folder and wait for its  completion. Go to the "Users" tab in the right pane,
right-click on a user and select "Limit on this user". Then right-click on the root of the scanned
directory and choose "Export" > "Copy List of Files" which may take a while. Then paste the
file list e.g. to a spreadsheet.

Q:Why does TreeSize Professional Professional not export the file  names to my Excel /
HTML / Text file?

http://technet.microsoft.com/en-us/library/ff686200(WS.10).aspx
http://technet.microsoft.com/en-us/library/ff686200(WS.10).aspx
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A: The export  functions  of  TreeSize Professional  were mainly  designed  to  export  information
about folders and their size. However, you can copy a complete list  of  files  to  the clipboard
using the context menu of any folder in the tree. You may also use the custom search type of
the TreeSize Professional File  Search to  list  all  or  some files  of  a  directory branch.  These
lists can be exported as well, e.g. to Excel files. You may also try our freeware command line
utility FileList which was designed to generate simple file lists without the overhead of a GUI
application.  Our  product  SpaceObServer  is  able  to  perform  the  exports  including  the  files
right from its underlying database.
To get a complete list of all subfolders when exporting please make sure that the Option "Full
Branch" is selected under "File" > "Export" > "Customize" > "Export".

Q:All  prints  on  my  Brother  laser-printer  appear  mirror-inverted.  How  can  this  be
corrected?

A: Please open your  "Control  Panel"  and select  "Printers".  Now  right-click on your  Brother
printer and select "Properties". In the Properties  dialogue click on "Advanced".  Here you
will  find a selection for  the print  processor  (modprint,  brprint,  winprint).  Please
choose winprint and try to print again.

Q:When I double click on a CSV file  they open in MS Excel but  the  data is  not  divided
into columns. Can this be changed?

A: In the Windows Control Panel, please set the list separator under Control  Panel  >  Regional
Options > Customize to semicolon.

10.4 File Search

Q:How can I search for files of the type XYZ?
A: Open the TreeSize Professional File Search via the Windows "Start" menu or  the TreeSize

Professional "File Search" menu, activate only the custom search type and check the drives
that should be searched, on the tab "Custom  Search"  enter  "*.XYZ" to  the list  patterns  that
should be matched, then press the "Start" button on the right. Another possibility: Set a filter in
the  Options  dialog  of  the  main  application.  Then  TreeSize  Professional  will  only  include
matching files when calculating the folder sizes. The results will provide a good overview  of
the distribution of these file type(s) and can be exported to a text file using the context menu.
Our product SpaceObServer, which keeps the data of watched file system trees in  an SQL
database, has faster and more flexible search and report features.

Q: Is it possible for TreeSize Professional to move files to a specified location based on
last change date and retain directory structure?

A: Please  start  the  TreeSize  Professional  File  Search  through  the  main  menu  of  TreeSize
Professional or the Windows Start menu. Activate only the "Oldest files" search type on the
"Search Options"  tab and adjust  the date on the "Oldest  files"  tab.  You  may  also  use  the
Custom file search if you need more flexible filter options. Then hit  the "Start"  button on the
right. All listed files that are checked can then be moved using the "Move Checked" button on
the right. If you choose another file system folder as destination, the directory structure will be
preserved when moving the files.

Q:How can I search my entire network for AVI files?
A: Open the TreeSize Professional Custom File Search using the Windows Start  menu or  the

TreeSize "File Search" menu. Make sure that  only the Custom  Search type is  activated on
the  "Search  Options"  tab  and  hit  "Browse  and  add  path",  choose  "Network".  On  the  tab

http://www.jam-software.com/freeware#filelist
http://www.jam-software.com/spaceobserver/
http://www.jam-software.com/spaceobserver/
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"Custom Search" add the pattern *.avi and hit "Start".

Q: Is it  possible  to  check several  or  all  results in  the  File  Search window at  one  time
instead of checking them individually?

A: To check all results, click on "Edit > Check All"  in  the main menu.  You may select  multiple
files  using  a  left  mouse  click  while  holding  the  <Shift>-  or  <Ctrl>-key  down.  Using
"Check" from the context menu checks all currently selected files. Some successive files can
also be easily checked by pressing the space bar several times. The space bar checks  the
currently focused file and advances to the next file in the list.

Q:Which files can I safely delete?
A: Unfortunately there is no short and easy answer to this question because usually one cannot

know where a file  came from  and what  it  is  used for.  Generally temporary files  and cache
files of the internet browsers can nearly always be deleted safely. Besides deleting files, the
file  search  of  TreeSize  Professional  offers  you  to  move  files  to  a  different  drive  or  to  a
compressed ZIP file which can then be archived. That way files that are still needed can be
easily restored.

Q:Does TreeSize Professional have the capability to delete files in specified directories
over a certain age and if so, can this be scheduled? 

A: The TreeSize Professional  File  Search can search,  report  and delete or  move files  over  a
certain age in using the "Oldest Files" search type or the custom search type. Check the files
you want to delete (use "Edit > Check All" to check-mark all files) and use the "Move" button
on the right to move them to the Recycle Bin or  to  another  folder.  Scripting this  is  possible
through  the  command  line  option  /MOVETO  (Professional  Edition  only).  Any  search  options
saved to an XML file can be passed at the command line and the results can be saved using
/SAVE  or  moved,  for  example:  TreeSize.EXE  /SEARCH  /MOVETO  "C:\Temp\TST\Moved"  "C:

\Temp\TSP\Files_ending_with_TMP.xml". You may pass "Recycle Bin" as destination as well:
TreeSize.EXE  /SEARCH  /MOVETO  "Recycle  Bin"  "C:\Temp\TSP\Files_ending_with_TMP.xml".
You may use "Tools  >  Schedule Current  Search Options"  to  open the TreeSize  Schedule
dialog.

Q:How can I change XY for each file in the search results in a scheduled File Search?
A: Start the TreeSize File Search. Please configure the custom file search appropriately, turn off

all  other  search types  and save your  search options  to  an XML config  file  using  the  "File"
menu.  As  an example we will  describe how  to  apply NTFS compression to  all  files  in  the
search results.  This  is  not  built  into  TreeSize Professional,  but  TreeSize  Professional  can
pass  each search result  to  an  executable  or  script,  which  is  a  very  powerful  and  flexible
feature. Please create a small Batch file NTFSCompress.bat containing:
  COMPACT /C %1

To NTFS compress the search results, you can use a command line like this:
  TreeSize.exe /SEARCH /MOVETO NTFSCompress.bat MySearchOptions.xml

This solution applies to the Professional Edition only.

Q:How do I perform a duplicate file search on multiple network drives?
A: Open the TreeSize Professional File search using the Windows Start menu or the TreeSize

Professional Tools menu, on the "Scan Options"  tab activate only the duplicate file  search,
add the network paths to the list of "Drives and Paths to Search"  and start  the search.  You
may change the way TreeSize Professional compares the files on the "Duplicate Files" tab.

Q:After deduplicating files, the Windows "Properties"  dialog still  shows the  same  size
for the containing folder. Why is this?

A: When deduplicating files, TreeSize Professional  replaces  duplicate files  by hard links,  after
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which the physical data exists only once on the hard disk. There are however X links to  this
data. Each of these links is shown with the size of the physical data, this is why the Windows
Explorer  and by default  also TreeSize Professional  shows  the same disk  usage  for  these
files  and the folders  they are included in.  If  you  take  a  look  at  the  allocated  space  of  the
physical drive (in the "Drive Panel" in TreeSize Professional or in the "Properties" of the drive
in the Windows Explorer) you will notice the difference. To get the correct physically allocated
size of a folder, you need to use the TreeSize Professional main application and make sure
that  the option  "Track  NTFS  Alternate  Data  Streams  and  Hard  Links"  is  turned  on  in  the
Options.

Q: Is it possible to scan all our 300 workstations with TreeSize Professional for finding e.
g. who stores PST files locally on his workstation?

A: What you can do is using the Custom Search type of the TreeSize Professional File Search.
It allows to  search an entire  Windows  domain for  certain  files,  like *.pst.  Simply specify  \
\YourDomainName  as path to search. TreeSize Professional  will  then enumerate all  available
PCs in that domain and search their drives (or more exactly: their public and hidden shares)
for the files matching the search criteria.

Q:Does  TreeSize  Professional  support  paths  with  more  than  255  characters  when
searching files?

A: Yes. Long path can be searched for using the Custom Search.

Q:How do you search for files over a certain number GB and older than a certain date?
 I'm trying to find data to archive on my file server

A: Please  start  the  TreeSize  Professional  File  Search  using  the  "File  Search"  menu  or  the
Windows "Start" menu, activate the "Custom Search" type only on the "Search Options" tab
and adjust the search parameters on the "Custom Search" tab accordingly. 

Q:Does TreeSize  Professional  change  any of  the  modified/accessed/changed  date  &
time information on files or folders when scanning?

A: No, TreeSize does not change file dates when scanning a file system branch. 

Q:Does TreeSize Professional allow to search for directories?
A: Yes. You can use the Custom  Search type of  the TreeSize Professional  File  Search to  do

that.  Start  the File  Search using  the  Windows  "Start"  menu  or  the  TreeSize  "File  Search
menu  and  open  the  "Size  /  Attributes"  tab  of  the  Custom  Search.  Select  the  "Directory"
attribute only. TreeSize Professional searches now for directories only. Example:  To find all
directories named "System32" use the pattern: *\System32

Q:Does TreeSize Professional allow to search for empty directories?
A: No. Empty directories do not occupy disk space on NTFS volumes, so searching for  empty

directories costs time, but does not free up disk space. Furthermore there are directories in
which programs  place (temporary)  files  only while  they run.  Deleting these directories  can
cause error  messages  or  malfunctions  when starting those programs  the next  time.  What
you could do is to export a scanned directory branch to  an excel  file  and use Excel's  "Auto
Filter" feature to filter those folders that have zero files  in  them.  Please make sure that  this
option is checked before exporting: File > Export > Customize > Excel > Export > Export Full
Branch.

11 Windows & Tabs

Toolbars
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File System Tree

Drive Panel

Chart

Details

Extensions

Users

File Ages

Top 100 Files

History

11.1 Toolbars

Directly  beneath  the  menu  bar  you'll  find  three  toolbars  showing  icons  for  fast  access  to
frequently used functions.  Every single  toolbar  may  be  turned  on  or  off  in  the  context  menu
(right-click on the toolbar). 

Toolbar "Scan"

The first  toolbar  "Scan"  includes  on  the  left  side  a  pull  down  box  with  drives.  Here  you  can
determine which drive should be scanned. TreeSize Professional saves those paths  that  were
last used in the pull down box for faster access. You can also enter a path directly and press the
"Enter"  key to  start  the  scan.  It  is  possible  to  use  environment  variables  like  %TEMP%  and
wildcards like '*' here.

Next to this box you'll find various icons for scanning of folders and drives. 

Starts the scanning process. Scans the drive or folder  selected in  the pull-down box on
the left

Lets you select a folder for scanning

Lets you scan the whole folder again

Turns on/off the automatic updating based on news from the Windows Shell

Remove this folder from scanning by TreeSize Professional 

Prints a report for the active folder

Moves back to the previously selected folder.

Moves forward again and so reverts the last click on the "Back" button.
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Move to the parent of the currently selected folder.

Change settings for viewing and folder scan

Opens the Software dialog from the Windows System Control

Shows the window for file search (see File Search)

Toolbar "Data"

The second toolbar Data includes icons for the viewing of collected data. 

Opens up the folder tree up to a certain level

Shows folder size

Shows how much disk space a folder requires

Shows how many percent of the superordinated folder each folder takes

Shows space, wasted by the file system

Shows how much space a folder would need on a CD-ROM 

Shows the number of files in a folder

Sorts elements alphabetically

Sorts elements according to their size

Shows elements without sorting

Shows values in kilobytes

Shows values in megabytes

Shows values in gigabytes

Uses an adequate unit of  measurement according to the size of the elements

Shows a pie chart for the active folder

Shows a bar chart for the active folder

Shows all information for sub-folders

Toolbar "Overview"

The third toolbar Overview shows you the active drive as well as its usage and seizure. 
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11.2 Directory Tree

The directory tree of the drive or folder scanned by TreeSize Professional can be viewed in the left
pane of the main window. It gives you a quick overview of the size of each folder. You may use
this tree just like a folder tree in Windows Explorer. If you place your mouse cursor on a folder
you'll be shown an elaborate tool tip with detailed information if the appropriate option is active in
the Options dialog.

The directory tree supports an incremental search, which is started if you start typing the initial
characters of a folder name when the directory tree is the active control.  It  will  then select  the
first matching folder.

With  "Branch"  >  "Update"  you  may  update  this  window;  with  "Branch"  >  "Expand"  you  can
determine to which level  the tree should show  sub-folders.  Try the menu bar  and the context
menu (right-click on a folder) in order to use more functions (see Context Menu)

11.3 Drive Panel

The  drive  panel  shows  the  local  drives  and  connected  network  drives.  More  network  drives
many be added by using the context menu (Professional edition only). 

You can see the size of the drive as well as free disk space. Double-clicking starts a scan of the
selected drive.

11.4 Chart

TreeSize Professional is able to visualize folder sizes as pie charts, bar charts or tree maps. A
chart  always  shows  the  size  of  the  sub-folders  of  the  currently  selected  folder.  A  pie  chart
shows the size, allocated space, wasted space etc.  depending on what  kind of  view  the user
selected in the toolbar. The bar chart shows the size,  allocated and wasted space together  in
one chart because:  branch size + wasted space = allocated space. If a bar chart doesn't fit in
the window, a scrollbar is displayed on the right side, which allows scrolling in the chart. 

In the pie chart, small folders may be summarized in a slice named "Other". If a root of a drive is
displayed in a pie chart and you have switched to the "Allocated Space" mode, the free space of
this drive will also be displayed as one slice of the pie. There is an option in the right click menu
of the pie chart to turn this behaviour on or off. The pie chart just shows the free space as one
slice among the others and calculates the percent appropriately (relatively to the others), so the
percent value might differ from the "% Free" value of the drive if TreeSize didn't see all files. An
FAQ entry deals with the possible reasons.

Clicking on a slice or  bar  shows  detailed  information  about  the  corresponding  folder,  double
clicking will change into the selected folder. Under View / Toolbars  or in the context  menu of  the
chart the chart toolbar can be turned on or off. It allows you to manipulate the charts in several
ways, for example zooming, turning on or off the grid lines, switching between 2D and 3D mode,
changing colors, etc. Using this toolbar, you can also copy the current chart to the clipboard or
save it as a file. The color of a chart element can be changed by selecting the appropriate color
in the color pull-down menu and then clicking on the chart that you would like to change.
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Choose Print Chart from the File menu to print a chart. A chart will be printed exactly as you see it
on the screen.

Displays the selected directory as pie chart.

Displays the selected directory as bar chart.

Displays the selected directory as tree map chart.

Copies the displayed graph to clipboard.

Prints the displayed graph.

Saves the displayed graph.

Toggles 3D view on / off.

Toggles the graph's legend on / off.

Toggles vertical grid lines on / off (available for bar charts only).

Toggles horizontal grid lines on / off (available for bar charts only).

Toggles  background  gradient  display  on  /  off  (available  for  bar  charts  or  pie
charts only).

Changes the graph filling from full color to shades. (available for bar charts and
pie charts only)

Allows to choose a color for changing the color  of  a  chart  element.  Click on a
chart  element  after  choosing a color  to  change  the  element's  color.The  right
click menu offers the possibility to reset the colors.

Zooms in

Zooms out

Shows the parts of all directories and files in the slices of the pie chart (available
for pie chart only)

Shows the parts of all file extensions in the slices of the pie chart (available for
pie chart only)

Shows the parts of all file users in the slices  of  the pie  chart  (available  for  pie
chart only)

Changes the file size resolution in the tree map display (available  for  tree map
charts only)

Context Menu
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The right click on any chart shows a popup menu that offers features to export or print the chart.

11.4.1 Tree Map

The Tree Map is a hierarchical chart that is able to visualize the sizes of each subfolder (not only
direct child folders) of a selected directory branch. 

Each  folder  is  shown  as  a  rectangle.  The  area  of  the  rectangle  represents  the  size  of  the
corresponding  folder.  The  rectangles  of  subfolders  are  located  inside  the  rectangle  of  their
parent folder. If a folder has no subfolders and file extensions statistics was activated during the
scan, the file types are now shown as subitems.

The color of the rectangle face indicates the directory level. The colors range from dark red (top
level directories) to bright yellow (directories with a deep file system level). These colors can be
adjusted using the color dropdown in the toolbar of the "Charts" tab. The shown rectangles must
have a minimum size to be displayed. You can customize this minimum value using a track bar
in the toolbar. If this value is  small the chart will be can be very complex and confusing.
If you place the mouse cursor over the chart, you will see a tooltip containing information about
the directory below  the  cursor.  Double  clicking  on  one  of  the  rectangles  will  navigate  to  the
corresponding directory in the directory tree. Drag and drop operations are supported in the tree
map.

You can use the same export functions as with the bar or pie chart (see Charts). Use Ctrl + and
Ctrl - to zoom the tree map, or use the mouse wheel while keeping the CTRL key pressed. Use
the cursor  keys,  Home,  End PgUp and PgDown to  scroll  the zoomed tree map.  Or  keep the
spacebar pressed while dragging the treemap with the left mouse button for scrolling, similar to
Photoshop.
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11.5 Details

The tab Details lists detailed information for sub-folders and files of the selected drive or folder.

You'll see a list of all elements in the selected folder. For each element many details are shown,
such as size, space usage, wasted space, number of elements, share in super-ordinate folder
in percent and the date of last access and last change. 

By right-clicking the mouse in the table's head, you may toggle on/off different columns.   

Copies the displayed list (or a selected part of it) to clipboard.

Prints the displayed list (or a selected part of it).

Saves the displayed list (or a selected part of it) to a file.

Saves the displayed list (or a selected part of it) to an Excel file.

Compress and saves the selected directory.

Moves the selected item(s) to the recycle bin. 
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Hold the "Shift" key pressed to remove the item(s) form the disk instead (Note:  You can
not recover files that are removed from the disk).

11.6 Extensions

The tab Extensions shows information on size grouped by file types. Thus you'll have an overview
of the types of files that use up most of the disk space. Use the toolbar  Data  in  order  to  select
specific  information for view and the sorting of data. By clicking on the corresponding icons  at
the upper part of the tab you may also save the file  type list  in  a  file,  print  it,  copy it  or  view  a
chart on the same tab as well. The statistics on file extensions can be activated and deactivated
in the Options dialog.

In the toolbar are these buttons:

Filter the file system tree so that only the sizes for the selected file extension are shown.

Turns off the filter again.

Shows a list of all files of the selected file type.

Copies  the contents  of  the list  to  the clipboard.  If  multiple  Items  are  selected,  only  the
selected items will be copied.

Saves the contents of the list to a file, several different formats are supported. If multiple
items are selected, only the selected items will be saved.

Saves  the contents  of  the  list  to  an  Excel  file.  If  multiple  items  are  selected,  only  the
selected items will be saved.

Prints the contents of the list. If multiple items are selected, only the selected items will be
printed.

Shows/Hides a small bar chart below the list.

Using this button the file types  can be grouped together  into  groups  like "Audio Files",  "
Video Files" or "System Files". 
You may configure the file groups in the Options dialog (See: "Options > File Groups").

 

11.7 Users

The tab "Users"  shows  information on size grouped  by  users.  At  a  glance  you  may  inspect
which user uses how much space in which folder. By using the icons in the upper part of the tab
you can save this list in a file, print or copy it or view a chart on the same tab as well. User that
do not own files in the currently selected file system branch will not be listed. The statistics  on
file owners can be activated and deactivated in the Options dialog.

By right clicking on the column header you may enable these additional column:

Full User Name The full name of the user, queries from Windows or Active Directory
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User Comment The user comment from Active Directory

Quota Usage The usage queried from Windows quota management. To see values in
the  quota  columns,  you  must  run  TreeSize  Professional  as
administrator  and  quota  must  be  enabled  on  the  local  drive  that  you
were scanning.

Quota Limit The size limit that is set for the user in the Windows quota manager.

In the toolbar are these buttons:

Filter the file system tree so that only the sizes for the selected user are shown.

Turns off the filter again.

Shows a list of all files of the selected user.

Copies  the contents  of  the list  to  the clipboard.  If  multiple  Items  are  selected,  only  the
selected items will be copied.

Saves the contents of the list to a text, several different formats are supported. If multiple
items are selected, only the selected items will be saved.

Saves  the contents  of  the  list  to  an  Excel  file.  If  multiple  items  are  selected,  only  the
selected items will be saved.

Prints the contents of the list. If multiple items are selected, only the selected items will be
printed.

Shows/Hides a small bar chart below the list.

 

11.8 Age of Files

The tab File Ages shows the distribution of the age of scanned files. Basis for ascertaining the file
age is the date of last change. Values for the specified period do not include the other, younger
periods.
The  toolbar  offers  export  features  equal  to  the  Charts  tab  and  allows  you  to  customize  the
intervals. The boundaries of the intervals are always rounded to full days, that means to 00:00 a.
m.
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Copies the displayed graph to clipboard.

Prints the displayed graph.

Saves the displayed graph.

Toggles horizontal grid lines on / off.

Toggles 3D view on / off.

Toggles background gradient display on / off.

Changes the graph filling from full color to shades.

Sets the file age intervals.

11.9 Top 100 Files

The tab Top 100 lists the 100 biggest files in the scanned branch together with some details. By
using the tool buttons in the upper part of the tab you may save this list to a file, print it or copy it.

Copies the contents of the list to the clipboard. If multiple Items are selected, only
the selected items will be copied.
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Prints  the  contents  of  the  list.  If  multiple  items  are  selected,  only  the  selected
items will be printed.

Saves the contents of the list to a  file,  several  different  formats  are supported.  If
multiple items are selected, only the selected items will be saved.

Saves the displayed list (or a selected part of it) to an Excel file.

Deletes the selected item(s).

Note: Files of the system directory "System Volume Information" and the "Recycle Bins" will not
be listed here.

11.10History

In the History  tab you can see line charts visualizing the size development  of  the selected root
folder. After each scan the size, allocated space and number of files of the root folder is stored
automatically in an XML file in users profile of the logged in user. These sizes are used to create
this view. So the shown interval and frequent depends on the scans you have done for this root
before.

Please note that only scans of the same path and the same exclude filters will  be displayed in
the history, because only those share a common base that makes them comparable.

If you are interested in the size development of subfolders in the scanned file  system  tree,  we
recommend  using  our  disk  space  manager  SpaceObServer,  which  archives  file  system
information in a database and is able to track size development down to file level.

The History toolbar includes the options to copy, save and print the shown graph.

Copies the displayed graph to clipboard.

Prints the displayed graph.

Saves the displayed graph.

Toggles 3D view on / off.

Toggles vertical grid lines on / off.

Toggles horzontal grid lines on / off.

Toggles background gradient display on / off.

Changes the graph filling from full color to shades.

Sets the minimum value as the graph systems origin.

Show marks including size values in the chart.

http://www.jam-software.com/spaceobserver/
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Shows or hides points on the line chart.

Besides the export options mentioned above, the context menu of the chart offers these options:

Remove This
Point

If the right click was performed on a point in the history chart,  then this  point
can be deleted permanently from the history using this command.

Purge Old History
Data

This command Allows you to delete old entries in the history. A date value will
be queried after you have chosen this command.

12 The Menus

File Menu

Export Submenu

Edit Menu

Branch Menu

View Menu

Sort Menu

File Search Menu

Tools Menu

Context Menu

12.1 File Menu

The File menu allows you to  select  folders  for  scanning,  to  remove folders  from  the TreeSize
Professional Window and to print or export the collected data.

Select Directory Shows  a  dialog  which  lets  you  choose  a  folder  for  scanning.  After
pressing OK TreeSize Professional  starts  scanning the selected path.
You  can  also  enter  a  path  directly  into  the  drive  combo  box  in  the
toolbar.

Recently Scanned A  list  of  paths  and  drives  that  were  recently  scanned  in  TreeSize
Professional. Clicking a path will start the scan of this path.

Load XML Report Opens a XML report that has been saved earlier. That way you can view
earlier results without performing a whole scan again.

Recently Saved A list  of  XML reports  that  have been  recently  saved.  Clicking  an  XML
reports loads it into TreeSize Professional.
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Save XML Report Save the information of the current file system branch to a XML file. This
file  can be  loaded  in  TreeSize  Professional  again  or  can  be  used  to
perform a comparison at a later time. TreeSize Professional ships with
a  XSLT  file  that  formats  the  data  inside  the  XML  file  for  output  in  a
browser that supports  XSLT processing (e.g.  Firefox >V1.0 or  Internet
Explorer >V5.5). Please note that the information about single files is not
saved to the XML because this would increase the size of the XML files
too much. Thus only the information about folders is included in the file.
If you need reporting on file level, our software SpaceObServer may be
useful for you.

Compare With XML
Report

Loads  a  saved  XML  report  and  compares  it  to  the  current  one  by
"subtracting"  the old  size  information  from  the  current  one.  That  way
folders  unchanged  in  size  will  show  up  with  a  size  of  0  after  the
comparison, folders that have grown will have values greater than 0 and
will be displayed in red color. Folders that became smaller compared to
the loaded report will have negative values and will be displayed in green
color. Please note that since the information about individual files is not
included in the XML reports, the detailed view will not show the change
of the size of individual files.

Export Only available in the Professional Edition. See chapter Export Submenu.

Set Title Allows you to set a title for the currently active branch which will be used
when the folder data is printed or exported. The default title includes the
path of the scanned folder and the volume name of the drive where the
folder resides in.

Print Report Prints a detailed report of the current folder. See Printing.

Print Report for All Prints a detailed report for all scanned drives / folders in the left pane

Print Chart Prints the currently visible Chart

Print Folder Contents Prints a list of all objects in the current folder  including the icons,  size,
date, etc.

Page Setup Shows  the Page setup dialog where you can  specify  the  margins  for
printing, paper size etc.

Printer Setup Shows the print setup dialog

Exit Closes TreeSize Professional

12.2 Export Submenu

The export of the File menu submenu is only available in the Professional Edition and allows you
to export the collected in data in different ways. You may customize the kind of data (columns)
that will be exported on the columns tab of the Options dialog. For all ways of exporting applies
that only those folders will be exported that are currently visible  (expanded)  on the left  pane of
the main window.  In the Options you can decide if all folders or just the visible folders should be
exported. That  way you can control  which data will  be exported either  manually by expanding
and collapsing folders or by using the context menu.

http://www.jam-software.com/spaceobserver/
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Save As Text Save the collected data to a tab-separated text file

Save as HTML Allows you to save a report as HTML file which can be viewed with any
HTML browser  later.  HTML files  are more easy to  read  than  text  files
and  don't  require  a  special  application  like  MS  Excel.  If  a  chart  is
currently visible in the right pane of the window, then it will be embedded
in the HTML file as an image. The HTML file will be UTF8-encoded and
thus includes Unicode characters. In the Options dialog a stylesheet file
can be set for the HTML export.

Export Data to Excel Exports the collected data to an MS Excel compatible file.  The formats
Excel  97-2003  (file  extensions  XLS)  and  Excel  2007  (file  extension
XLSX) are supported. Paths that are exported to Excel files are exported
as  clickable  hyperlinks.  This  allows  you  to  quickly  jump  to  the
appropriate path in Windows Explorer

Copy to Clipboard Copies the data of the current file system branch to the clipboard in text
format

Send by Email Sends the current data as a text email via Windows MAPI. This requires
that MAPI is configured properly, which can be done in the Control Panel
using the applet "Mail".

Customize Opens  the  Options  dialog  which  allows  to  customize  the  output
columns

Copy List of Files Copies a list of all files in the current folder  (and its  sub-folders)  to  the
clipboard. You can paste this  list  to  your  favorite  spreadsheet  or  word
processor. The columns that will be included in the list  are determined
by the settings for the text export in the Options dialog. Please note that
activating the owner  or  permission column will  significantly slow  down
the export process because querying this information under Windows is
a slow operation.

12.3 Edit Menu

This menu contains function similar to the Edit menu of the Windows Explorer.

12.4 Branch Menu

The main menu bar  has  a Branch  menu that  contains  some  actions  that  can  be  applied  to
complete scans / branches.

Update Rescans the current directory branch completely

Automatic Updates Allows you to turn automatic updates on or off for the currently selected
scan. If automatic updates are turned on TreeSize Professional  keeps
track  of  the  Windows  change  notifications  and  updates  the  changed
folders.  It  will  also  update  the  size  of  a  folder  if  it  gets  listed  on  the
details sheet. If you don't want the size information to  change after  the
scan has finished, you should turn off "Automatic Updates".
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Expand The Expand submenu equals the one in the context menu.

Remove From
TreeSize

This menu item will remove the currently selected scan from the view.

12.5 View Menu

Toolbars Allows to turn the toolbars on or off

Show Drives Panel Allows to turn a list with local and remote drives in the lower left corner
of the main window on or off .

Right Pane Lets you choose which information is displayed on the right pane of the
window.

Decimals Choose the number  of  decimals  that  should  be  used  when  TreeSize
Professional displays or prints values.

You can choose different types of values for displaying in the tree on the left side:

Size In this mode the size of the files in a folder including all sub-folders will be
shown.

Allocated Space This  will  show  the  amount  of  space  that  is  allocated  on  disk  for  this
folder, again including all sub-folders.

Percent Shows  how  many  percent  of  the  parent  folder's  size  each  folder
occupies

Wasted Space Shows  the amount  of  space that  is  wasted  by  the  file  system  for  the
storage of all files in this folder, including all sub-folders

CD-ROM Cluster Size This mode will show how much space a folder would occupy on a CD-
ROM. Please keep in mind that some space on the CD will be needed to
store the directory information.

File Count Shows the number of files in each directory branch.

Use  the  next  menu  items  to  switch  between  different  tab  sheets  for  the  right  pane  of  the
TreeSize Professional main window:

Chart Shows a chart on the right side of the window.

Details Shows  a  detailed  list  with  all  objects  in  the  current  folder.  For  each
object,  you  can  see  the  size,  the  allocated  and  wasted  space,  the
number of files, the last access and change date and the percent of the
parent folder. 

Extensions Shows  a  statistic  for  the  currently  selected  file  system  branch  that
shows the size of each file type in this branch.

Users Shows  a  statistic  for  the  currently  selected  file  system  branch  that
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shows a statistic for the users with the summarized size of all files that
he owns. 

File Ages Shows the distribution of the file ages in a bar chart.

Top 100 Files Shows a list with the Top 100 largest  files  in  the scanned directory or
drive.

You can change the way  TreeSize Professional displays the sizes using these menu items or
the corresponding toolbar buttons.

Values in Bytes All size values will be shown in Bytes

Values in KB All size values will be shown in Kilobytes.

Values in MB All size values will be shown in Megabytes.

Values in GB All size values will be shown in Gigabytes.

Automatic Units For each value an appropriate unit (KB/MB/GB) is chosen automatically

To change the main settings of TreeSize Professional:

Options Shows the Options dialog.

12.6 Sort Menu

Sort by size The largest folders will be displayed first.

Sort by name The folders will be sorted alphabetically.

No Sorting No  sorting  is  done.  This  can  be  useful  when  scanning  large  folders
drives because folders don't permanently change their position.

12.7 File Search Menu

This menu starts the TreeSize Professional File Search with one or  all  search types.  For  more
information please see the chapter "File Search".

12.8 Tools Menu

Update all Rescans  all  folders  which  are  currently  listed  in  the  TreeSize
Professional main window. You can update an individual  folder  through
the context menu of this folder.

Group all Scans in a
Virtual Root

Using this feature it is possible to group scans under a virtual root folder.
This  virtual  root  folder  shows  a summary of  all  scans  that  are part  of
this  group.  This  way you  can  merge  different  scans  together  e.g.  for
printing or exporting. You can add or remove scanned paths individually
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from the virtual root folder using the context menu.

TreeSize File Search Shows  the "File  Search"  window  which allows  to  search  for  obsolete
files

Start TreeSize as
Administrator

This menu item, which is only available under Windows Vista, will start
TreeSize again with full administrative privileges.

Schedule TreeSize
Scan

Opens a window that helps you to schedule scans

Manage Scheduled
Tasks

Allows to edit previously created Scheduled Tasks.

Add/Remove Software Opens the Add/Remove Software applet of the control panel

Configure Windows
System Restore

Open  the  configuration  of  the  Windows  system  restore,  which  can
consume a significant amount of disk space on a system.

Empty Recycle Bin Empties the recycle bin of Windows

Defragment Disks Open the Windows defragmenter

Connect Network DriveOpens a window that allows you to  connect  a  network drive to  a  drive
letter (Professional Edition only)

Options Shows the Options dialog.

12.9 Context Menu

File System Tree

When you right-click on a folder or file in the tree on the left, TreeSize Professional  will  display
the Explorer  context  menu.  Additionally you will  find the following menu items  in  the TreeSize
Professional submenu.
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Apply NTFS
Compression

Compresses  the entire  directory branch using NTFS Compression.  TreeSize
Professional updates  its  statistical  data while  it  compresses  the branch.  This
operation can take a long time, depending on the amount of data that needs to
be compressed.

Decompress Decompresses  all  files  in  the  selected  directory  branch  for  which  NTFS
compression is  turned on.  This  operation can  be  used  to  reverse  the  above
operation.

New Folder Creates a new folder in the selected folder

Expand See below

Update this
Branch

Updates the statistical data for the selected subdirectory. This is usually faster
than updating the whole directory.

Update this
Folder
(non
recursively)

Reads the contents of this directory again and updates the statistics, but does
not recurse into subfolders.

Find Deepest
Nesting

Searches the folder with the deepest directory level. This can be useful  to  find
folders that violate the path limit of Windows of 255 characters.

Remove from
TreeSize
(Temporarily)

Using this menu item you may remove a folder from TreeSize Professional  and
its  calculations.  The removal  is  only temporary,  the folder  will  not  be  deleted
physically from the disk. Thus it will show up again during the next scan.

Remove from
TreeSize
(permanently)

The selected folder will be permanently removed from   TreeSize Professional
 and its calculationsby adding it to the Exclude list.
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Search with
TreeSize File
Search

Opens the TreeSize Professional File Search and makes this folder  the active
folder for searches.

Copy Branch
Data to
Clipboard

Copies  the  collected  statistical  data  of  all  folders  in  the  selected  directory
branch to the clipboard

Export As Allows to  export  this  subbranch of  the file  system  to Excel,  HTML or  text  file,
similar to File > Export.

Copy List of
Files

Copies a list of all files in the selected directory branch to the clipboard

Copy Full Path
to Clipboard

Copies the path of the current directory to the clipboard as text.

The topmost item of each scanned folder has a different context menu which looks like this:

Open Opens the selected folder in a simple Windows Explorer window

Explore Opens the selected folder in a Windows Explorer window with directory
tree on the left

Properties Shows the Properties dialog of the folder or drive

New Folder Creates a new folder

Windows Explorer Shows  the  context  menu  of  the  Windows  Explorer  for  the  scanned
folder or drive.

Update Rescans the current directory branch

Update this Folder Reads  the contents  of  this  directory again and  updates  the  statistics,
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(non recursively) but does not recurse into subfolders.

Expand See below

Export data See Export Submenu

Find Deepest Nesting Searches the folder with the deepest directory level. This can be useful
to find folders that violate the path limit of Windows of 255 characters.

Merge in Virtual Root Using this feature it is possible to group scans under a virtual root folder.
This  virtual  root  folder  shows  a summary of  all  scans  that  are part  of
this  group.  This  way you  can  merge  different  scans  together  e.g.  for
printing or exporting.

Remove From
TreeSize

This menu item will remove the currently selected scan from the view.

Search with TreeSize
File Search

Opens the TreeSize Professional File Search and makes this folder the
active folder for searches.

Scan Always on
Startup

If  this  option is  is  activated,  TreeSize  Professional  will  start  scanning
this folder if it is started and no other paths are passed on the command
line or from the Explorer context menu.

Show All Errors Displays  a  list  with  all  errors  that  occurred  during  the  scan,  e.g.
directories that could not be listeed due to missing access rights.

The Submenu "Expand"

Full Expand Expands the selected folder and recursively all its sub-folders

To Level X Selecting this menu item will show the first x levels of the current folder

Expand Folder over This  menu  item  allows  you  to  expand  only  those  folders  in  the  tree
which are larger than a certain size.

Remove Folder
<xxxMB

Selecting this menu item will remove all folders which are smaller than a
certain size from the directory tree.

Set Size Allows you to specify the folder size for the above two operations

Context Menu on the "Details" tab

The list on the Details tab shows the Windows Explorer context menu when you right-click on an
item.  Additional  a  submenu labeled TREESIZE  is  included  which  shows  all  information  that  is
available  about  the selected item  including the columns  that  are  currently  not  activated.  This
submenu may also be used to activate or deactivate columns.

13 Options

This Options dialog of TreeSize Professional can be opened using the appropriate menu item in
the View menu. It allows you to change the view and scan options and consists of the following
tabs:
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View

Scan

Include / Exclude

Columns / Export

Startup

Miscellaneous

Age of Files

File Groups

13.1 View Tab

Determine Icons based
on File Extension onl

If  this  option  is  turned  on,  then  TreeSize  Professional  uses  the
default icon for  files  based on the file  extension only.  This  is  much
faster, especially on network drives, because Windows opens many
file types in order to see if there are any icons inside. By default, this
option is turned on.

Different Colors for
Compressed Files and
Folders  

If this option is turned on, compressed files on an NTFS volume are
shown in a blue color. Folders that are partially compressed will have
a dark blue color, files and folders  that  are entirely compressed will
show  up  in  a  light  blue  color.  For  more  information  on  file  based
compression see Notes on NTFS.

Show Folders containing
Paths >255 chars in red

Folders  that  contain  objects  which  have  a  path  that  exceeds  255
characters  will  be shown in  red color.  This  is  useful  for  finding  file
system  structures  that  exceed the  Windows  MAX_PATH  constant;
many tools and the .NET framework have problems with  these long
paths.  Using the custom  search  of  the  TreeSize  Professional  File
Search you also can search for such files.

Show Long Tooltips in the
Tree

If this option is active a tool tip  window  with  detailed information will
be shown if the mouse cursor pauses over a folder for a while. This
is  useful  if  you want  to  take a look at  some detail  information  of  a
folder without switching to the Details tab.

Show Gradient Bars in
Directory Tree

If  this  option  is  active,  below  a  folder  in  the  directory  tree  now  a
gradient bar is shown that indicates the size of the folder in relation to
the entire scanned file system tree.

Show Time with Date
Values

This option allows you to decide if time values should be shown with
the last access, last modified and the creation date.

http://msdn.microsoft.com/en-us/library/aa365247%28VS.85%29.aspx
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Automatically Update
Right Pane During
Scanning

If this option is turned on the right  pane of  the main window  will  be
updated from time to time. This allows you for example to watch the
bars of a chart growing while scanning large drives. Use the drag bar
to set the interval of the updates.

Number of Folders in the
Recently Used list

Adjust  the  number  of  recently  scanned  folders  that  TreeSize
Professional should remember for quick access in the the pull-down
box in the toolbar.

Bold Factor If the size of a folder is greater than the set  percentage or  absolute
value of the complete size of the scanned folder, the folder label will
be shown bold. This allows you to  quickly find the largest  folders.  If
you don't want bold folder labels, choose "100%". 

Use bold Text and Colors
for Printed Reports too

Use  this  checkbox  to  define  if  the  text  formattings  like  bold  (see
above)  or  the  colors  when  comparing  scans  should  be  applied  to
printed reports too.

13.2 Scan Tab

The  settings  on  this  page  affect  the  behaviour  of  TreeSize  Professional  during  scanning.
Changes on these settings usually require a rescan of the currently scanned drives and folders
to take effect.

Follow External Mount
Points and Symbolic
Links

You can decide if TreeSize Professional should follow symbolic links
and mount points (see Notes on NTFS for additional information) that
point to other drives or folders on other drives. Links that point within
the  scanned  directory  will  never  be  followed  in  order  to  prevent
circular references and folders from being counted twice.

Track NTFS Alternate
Data Streams and Hard
Links

With  this  option  you  can  control,  if  TreeSize  Professional  should
check each file  if  it  is  just  a  hard  link  to  another  file  or  if  contains
alternate  data  streams  (ADS).  The  will  result  in  more  accurate
results for the allocated space, but will also slow down the speed of
a scan.

Show Error Messages Use this option to decide if TreeSize Professional should show error
messages during scanning. If you for example scan a network drive
on a Windows  server and don't have reading access  to  all  folders,
Windows will pop up an error message for every unreadable folder. If
you don't want the scanning process interrupted by these message
boxes, deselect this check box.

Create Statistics on File
Extensions

If  this  check box is  activated TreeSize Professional  will  additionally
generate  a  statistics  for  the  file  extensions  in  each  subtree.  The
results  can  be  viewed  on  the  Extensions  tab  of  the  main  window,
where you are also able to filter the values in the directory tree by one
file type.

Create Statistics on File
Owners

If  this  check box is  activated TreeSize Professional  will  additionally
generate a statistics for the file owners in each subtree. The results
can be viewed on the Users  tab of  the main window  where you are
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also able to limit the values in the directory tree to one of the users.
Since it is  necessary to query the owner of each file, this  option will
slow down the scanning process if activated.

Thread Priority Allows to define the priority with  which the threads  are running that
are scanning the hard disk. Idle means that they use the CPU will be
used only if no other threads are using it. Idle is a good setting if you
want  to  make sure that  a  scan with  TreeSize Professional  has  no
impact  on  the  performance  of  the  PC  or  server.  The  default  and
recommended value is  "lower  priority".  Choosing higher  priority  will
result in the scan threads having a higher priority than the thread of
the user interface, which can make the user  interface unresponsive
during  a  scan.  This  setting  is  also  used  for  the  threads  of  the
TreeSize File Search.

Maximum Number of
Threads

TreeSize Professional  automatically adjusts  the number  of  threads
to the CPU usage. This option lets you define the maximum number
of threads that will be started for a scan. If  the system  load is  high,
fewer than the maximum number of threads may be started.

User Defined Cluster Size Use  this  option  to  see  what  the  values  for  allocated  and  wasted
space would be with a different cluster size or file system. Changing
this option will require a rescan. This options will not be saved when
you exit TreeSize Professional in order to avoid wrong results  when
using it the next time.

13.3 Include / Exclude Tab

The Include/Exclude tab allows you to filter the scanned files and folders:

Patterns If  you  need  information  about  e.g.  certain  file  types  only,  you  can
specify  a  filter  here.  You  may  use  multiple  filters  separated  by
semicolons. So if you for example want to see how much space your
executable files and their  libraries  occupy,  use the filter  "*.exe *.dll"
here. If you want to include all files leave the field blank. You can also
specify a fragment of a path, e.g. "*\My Videos\*", this can be useful
for getting the size of only certain folders. 
Changing this option will make a rescan necessary. This options will
not be saved when you exit TreeSize Professional  in  order  to  avoid
wrong results when using it the next time.

Include only Files Created
in the Past XX Days

This  option is  quite  self-explanatory and can be useful  to  calculate
the size of backups or to identify "heavy growing" folders.

Include only Files with
Archive Bit Set

This option is useful if you are interested in the size of a backup that
will be performed on the basis of the Windows Archive Bit.

Excludes If  you  want  to  exclude  certain  files  or  folders  from  scanning,  add
matching  patterns  here.  A  pattern  may  look  like  "Windows"  or  "*.
tmp". Files or folders matching one of  the specified patterns  will  be
ignored during a scan.
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Exclude Offline Files This option allows to exclude files that are marked as Offline. Offline
files are often not physically present on the disk or  are only cached
temporarily on the local disk.

13.4 Columns / Export Tab

The Columns tab allows you to choose the columns that should be visible. You may choose the
columns separately for each "output media" (details view, Excel export,  printed report,  text  file,
CSV-Datei) by first selecting the appropriate entry in the pull-down box on the top. The following
columns are available:

Name The name of the folder or file

Full Path The full path, including the object's name

Size The size of the object

Allocated The space that the object currently occupies on disk (see also: Wasted
Space and NTFS Compression)

Files The number of files in a directory branch
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Folders The number of sub-folders in a directory branch

Wasted The  amount  of  space  that  is  wasted  by  the  file  system  (see  also:
Wasted Space)

% of Parent The amount of space in percent that a folder or file occupies relative to
its parent folder

Last Change The last change date of the object. TreeSize Professional calculates the
last  change  and  last  access  date  more  precisely  than  the  Windows
Explorer, because it takes all files in all sub-folders into account. So the
values shown in the Windows Explorer may differ.

Last Access The last access date of the object

Compr. The size in percent by which an object has been compressed using the
built in compression of the file system (see also: Notes on NTFS)

Owner The user name that owns a folder or file

CD-ROM Size The amount of space that an object would occupy on a CD or DVD with
ISO file system

Current Date The current date. This column can be useful if you want to process the
collected data, e.g. in a database.

Attributes The file attributes  Read-only (R),  Hidden (H),  System  (S),  Archive (A),
Offline (O).  Files  containing  NTFS  alternate  data  streams  are  shown
with an asterisk (*) here.

File Type The file type, e.g. "Text file"

Dir Level The level of an object in the file system. This value can be useful when
processing the collected data.

Creation Date The date at which the object has been created

Path (Without Name) The full path to object, not containing the object's name

Avg. File Size The average size of a file in a folder

Permissions The access permissions of the object  in  the format:  Username1:  +/-R
+/-W +/-X   Username2: ... where "+" means the right is  granted and "-"
means that the right is  denied. "R" stands for read access and "W" for
right access. For files "X" means the right to execute, for directories the
right to list the directory content.

Inherited Permissions These are the permissions inherited form the parent directories.

Own Permissions These are the own permissions  defined especially for  this  file  system
object.

File Version The  version  number  that  is  included  in  EXE,  DLL  OCX  and  similar
binary files

Title of Scan By default  the title  (volume label  and drive letter)  of  a  scan.  It  can  be
changed using Set  Title  in  the File  menu.  This  value can be useful  for
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archiving purposes.

MS Office Author This  column  shows  the  author  information  that  is  extracted  from  the
meta data of the file, taken from MS Office and compatible files.

MS Office Last Save
Date

This column shows the date on which the file was saved the last  time,
taken from MS Office and compatible files. This information is extracted
from the meta data of the file.

Hard Links The number of hard links to a file. Empty in case of folders.

Error In  case a  folders  could  not  be  scanned,  this  column  will  contain  the
message of the error that occurred.

MD5 Checksum Shows  a  string  representation  of  the  MD5  checksum  for  this  files
content.

SHA256 Checksum Shows  a string representation of  the  SHA256  checksum  for  this  files
content.

Extension The extension of the file, e.g. ".txt" for a text file.

Path Length Shows the number of characters included in  the full  path of  this  file  or
folder.

Alternate Data
Streams

Shows  the  size  hold  by  "Alternate  Data  Streams"  for  this  file  (not
available for directories).

Note: The column settings of the text export also effect the export to clipboard!

The column that should be visible in the details list can easily be selected by right-clicking on the
column header:
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Export

Full Export With this option activated, the whole file system tree that was  scanned
will be exported or printed.

Expanded Folders
Only

Only  those  parts  of  the  file  system  tree  will  be  exported  that  are
expanded on the left pane of the main window.

Header Line Use this option to control if a header line containing the column headers
should be added to the exported file or the printed report.

Units If the check box "Include in Export" is  checked, units like "KB", "MB", or
"%"  will  be  included  in  the  exported  data.  Uncheck  this  option  if  you
would like plain values to be exported. Without the units  the thousands
separators  will  also be omitted,  which simplifies  further  processing  of
exported values. Check the check box "Always Use Byte Values" if you
would always like plain  byte values  to  be exported,  independent  of  the
currently used unit.

Default Export File Here you can specify an Excel  file  into  which exported data should be
written by default (Professional Edition only).

Column Width This option is only available for printed reports and allows you to adjust
the  column  width  of  the  column  that  is  currently  selected  in  the  list
above.
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13.5 Startup Tab

On  this  tab  you  can  choose  if  TreeSize  Professional  should  always  be  started  with
administrative privileges. You can further define what TreeSize Professional  should do when it
starts without a path to  scan.  It  may scan a list  of  fix  paths,  it  may scan the paths  that  were
active the last time it was used, or it may simply do nothing, which is the default behaviour.

13.6 Miscellaneous Tab

This tab allows you to import/export your user settings and to configure the shell  extensions  of
TreeSize Professional for the Windows Explorer.

Settings Here you can export your TreeSize Professional user settings or import
user settings that were exported before. Additionally you may reset your
user settings to the factory settings.

Explorer Context Menu With the first checkbox you can decide if TreeSize Professional should
appear in the context menu of folders in the Windows Explorer.  A click
on this menu item will then start TreeSize Professional  which will  start
scanning the selected folder immediately.
The second checkbox allows to create an additonal context menu entry
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that starts the TreeSize Professional File search.

Explorer Column Use  this  option  to  enable  or  disable  the  "TreeSize"  column  for  the
detailed view of  the Windows  XP/2003 Explorer  which shows  not  only
the file sizes but also the folder sizes. If enabled you can control the unit
and the number of decimals here. The Explorer column is not supported
under  Windows  Vista  or  higher  because  Microsoft  removed  the
interface for adding columns to the Windows Explorer.
Note: The TreeSize column can only be configured here if you choose "
Install  TreeSize  column  for  Windows  Explorer"  within  the  TreeSize
Installation. Otherwise this option is disabled.

13.7 Age of Files Tab

This tab allows you to configure the intervals that are used to  generate the chart  with  the files
ages. You may change the limit of each interval, add additional intervals using the '+'  button, or
remove intervals  using the '-'  button.  You can turn off  the  creation  of  the  File  Ages  statistics
using the check box on top of the list. This  will  slightly reduce the memory usage of  TreeSize
Professional. Furthermore you can decide if  the file  ages  should be determined based on the
last  access  date,  the last  change date or  the file  creation date;  the default  setting  is  the  last
change date.
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13.8 File Groups Tab

Use this tab to configure the groups of file types which can be shown on the "Extensions"  tab.
You may add new groups, remove groups, modify the patterns of a group or change the caption
or description.
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14 File Search

The TreeSize Professional File Search can be started through the Windows "Start" menu or the
15:01 "File Search" menu and offers  the ability  to  search for  obsolete files  are perform  a fully
customizable search.

The File Search Window

File Search Menu

File Search Options

Biggest File Search

Oldest File Search

Temporary File Search

Internet File Search

Duplicate File Search



File Search 63

TreeSize Professional - File Search

Custom File Search

Moving found files

14.1 The File Search Window

The TreeSize Professional File Search can be started through the Windows "Start" menu or the
15:01 "File Search" menu and allows you to search for big, old and temporary files. You will find
the following tabs on the top of the window:

Biggest Files This  page allows  to  search for  the  biggest  files  on  your  hard  disk.  You  can
specify a minimum size in kilobytes or megabytes. All files larger than this value
will be shown in the list.

Oldest Files This  page  allows  you  to  search  for  files  that  have  not  been  changed  or
accessed since a certain date. You can limit the search to entire folders. In this
case only folders will be listed in which all files match the search criteria. This
allows you to identify branches of the file system that are not in use any more.

Temporary
Files

This page allows you to search for temporary files. Use the Configure  button to
customize the settings of the Temporary File Search.

Internet Files This page allows you to search for temporary internet  files  like the files  in  the
cache of the browsers  Netscape Navigator  and Internet  Explorer.  The search
for temporary internet files can be automated with  the command line option /
SEARCH:Internet.

Duplicate Files This page lists files which are on your disk more than once. You can choose if
duplicates should be indicated by equal name, size and last change date, or by
a compare of the md5 checksum  of  their  content.  Comparing the file  content
provides  more accurate results,  but  the  search  will  take  longer.  A  minimum
size speeds up the compiling of the list and prevents you from looking through
many small files. A check box allows to control whether or not the exclude filter
should be used.  The context  menu offers  the  possibility  to  replace  duplicate
files with hard links.

Custom SearchThis page allows you to define a fully customizable file search. You can filter by
filename, date, size, attributes and owner.

Scan Options Here you can choose which drives and which of the above search types will be
included in the search. You can add additional paths to the list by pressing the
button below the list. All checked drives will be included in the search. Network
drives are only supported in the Professional Edition.

You will find the following buttons on the right side of the window:

Start This button will start the search. You can now already look at the partial
search results by selecting one of the tabs. You will hear an acoustical
signal when the search is finished.
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Stop Stops the currently running search

Save Results This button allows you to save the search result  of  the currently active
search type to a text or CSV file.  The save dialog has an option to save
all result lists (instead of the active one only), and an option to save the
checked files only. Only the currently visible columns will be saved.

Move Checked This  button allows  you to  move  all  files  in  the  lists  which  are  check-
marked to the left of their file name to a position in  the file  system  that
you may specify. 

If you choose a file  system  location all  files  will  be moved there under
preservation  of  the  file  system  structure.  You  may  also  move  the
checked files  to  a  ZIP  file.  Optionally all  performed  operations  can  be
written to a log file.

TIP:  You can easily check a group of  files  by  keeping  the  space  bar
pressed or by selecting multiple files with the Shift or Ctrl key and then
use the context menu.

Deduplicate Checked This  button is  only  visible  on  the  "Duplicate  Files"  tab.  It  replaces  all
checked duplicates  with  links  to  the  same  file.  If  the  files  are  on  the
same  partition,  then  all  files  will  be  hardlinks  to  the  same  content.  If
creation  of  a  hardlink  is  not  possible,  a  symbolic  link  is  used  under
Windows Vista and later. If this is not possible too, a Windows shortcut
will be created instead as fallback.

With the File Search Menu items you can save and load your search settings (File menu), start
and abort searches (Search menu) or customize the information shown in the result lists (View
Options).
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14.1.1 File Search Menu

File

Load Search
Options...

Loads previously saved search options from a XML-file.

Save Search
Options....

Saves the current search options in a XML-file.

Reset Search
Options

Resets the current search options to their default values.

Save Results... Saves the results of the latest search.

Export Paths... Exports search paths in a txt-file.

Import Paths... Imports search paths from a txt-file.

Copy List to
Clipboard

Copies the currently visible result list to the clipboard. Use the right click
menu of the list to copy only the selected items.

Print List Prints the currently visible result list.

Print Setup Allows to configure the printer and its settings.



TreeSize Professional66

TreeSize Professional - File Search

Exit Exits the program

Edit

Cut Removes the selected items and copies them onto the clipboard.

Copy Copies the selected files and folders to  the clipboard.  To put  them  in  a
new location, use the "Paste" command.

Check All Check-marks all items in the active result list.

Uncheck All Uncheck-marks all items in the active result list.

Check All matching
Patterns...

Check-marks all items in the currently visible result list, for which the full
path matches customizable patterns.
The patterns can be configures in a shown form.

Uncheck All matching
Patterns...

Uncheck-marks all items in the currently visible result list,  for  which the
full path matches customizable patterns.
The patterns can be configures in a shown form.

Select All Selects all items in the list.

Invert Selection Inverts the selection.

Search

Start Searching Starts the file search.

Stop Searching Stops the file search.

Move Checked Files Moves  check-marked  files  to  a  destination  of  your  choice.  Every
movement can be logged.

View

Visible Columns Let you set the visible columns in the search result list field. They include
:

     Path      - the path of a file

     Size      - the size of a file

     File Type /
Matching Criteria

     - the file type or other matching criteria you looked for

     Last Access      - the date of the last access

     Last Change      - the date of the last change

     File Owner      - the user name of the file owner. Please Note : Querying file owners
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is  a  slow  operation  under  Windows  and  can  be  turned  off  here  if  not
needed.

     Attributes      - the attributes of the file (Details).

     Version      - the version number (If included in the file)

     Permissions      - The access permissions (Details).

     Creation Date      - The date when the file was created.

     Author      - The author included in many MS Office documents.

Size Unit Determines the unit, in which file sizes will be mentioned

     Bytes      - all sizes are given in Bytes

     KB      - all sizes are given in Kilobytes

     MB      - all sizes are given in Megabytes

     GB      - all sizes are given in Gigabytes

     Mixed Units      - uses the next appropriate size unit

Decimals Determines the number of decimals shown in a displayed number

     0      - shows no decimals

     1      - shows one decimal

     2      - shows two decimals

     3      - shows three decimals

Compressed Files Determines,  if  shown  file  sizes  are  based  on  normal  file  sizes  or  on
compressed file sizes.

     Use File Size      - uses normal file sizes

     Use Compressed
Size

     - uses compressed file sizes

Follow Mountpoints
and Symbolic Links

You can decide if TreeSize Professional should follow symbolic links and
mount points (see Notes on NTFS for additional information) that point to
other drives or folders on other drives.

Check Search
Results by default

Activate this  option  if  you  want  all  results  appearing  in  the  results  list
being checked automatically.

Show Long Tooltips
in Lists

Enables long tool tips in lists

Show Time with Date
Values

Allows  to  define,  if  the  time  should  be  shown  along  with  date  values.
When cleaning up old files, often just the date matters, but not the time -
omitting the time makes the result lists easier to read.
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Tools

Empty Recycle Bin Empties the Recycle Bin (the trash folder).

Start File Search as
Administrator

Starts  the TreeSize Professional  File  Search again and request  admin
privileges for it.

Schedule Current
Search Options

Opens a dialog that allows to create a Windows  scheduled task for  the
current search options.

Manage Scheduled
Tasks

Allows to edit previously created Scheduled Tasks.

Help

File Search Help Opens the FileSearch specific Help file

File Search F.A.Q. Opens the FileSearch specific F.A.Q.

Check for Update... Checks for a newer version of TreeSize

About... Provides information about TreeSize

14.1.2 File Search Options

The tab Scan Options allows you to configure the file search in different ways.

Drives and Paths to include

Use the check boxes in front of each drive to select which paths should be searched by the file
search. You can add additional paths and network drives using the buttons  below  the list.  The
first button will allow you to type in a path, the second one will open a folder browser dialog.
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You can search entire servers or PCs by using their UNC name like \\SERVER. You can search
your  entire  domain by using its  UNC  name,  e.g.  \\DOMAIN.  You  can  even  search  you  entire
network  by  choosing  the  network  neighborhood  of  Windows  in  the  directory  browser  that
appears after pressing Browse and Add Path. TreeSize Professional automatically browses for
PCs and all shares on them (including hidden shares)  and performs  the search on all  shares
that it finds.

Enabled Search Types

Use the check  boxes  in  front  of  each  item  to  enable  or  disable  certain  search  types.  Each
search type will be represented by a separate register.

Files / Folders to Exclude

The  file  search  was  designed  to  identify  obsolete  or  very  large  files  in  order  to  clean  up  a
system.  Certain  files  like  system  files  should  however  not  be  deleted  because  they  are
necessary for the operating system or other software to run. Files known to be important  for  a
system can be added to the exclude list here and will then not be shown in the results any more.
New entries in this list can be easily added using the right click menu of the result lists.

Additionally you may exclude files that have been changed in the past  hours.  If  a  file  has  been
changed recently there is a high probability that the file is not truly obsolete.

Please note: This option will by default NOT be applied to the duplicate file  search and to  the
custom  file  search.  However,  you  can  enable  it  by  check-marking  the  corresponding  check-
boxes on the registers of the duplicate search and the custom file search.

14.2 Biggest File Search

This  page allows  to  search  for  the  biggest  files  in  your  selected  path(s)  /  drive(s).  You  can
specify a minimum file size in kilobytes or megabytes. All files larger than this value will appear
in the search result list.

Search  for  files  bigger
than...

 Defines the minimum size for wanted files.

Like in all searches, you can move all files in the result list which are check-marked to the left of
their  file  name,  to  a  position  in  the  file  system  that  you  may  specify.,  by  using  the  Move
Checked button.
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14.3 Oldest File Search

This page allows you to  search for  files  in  your  selected path(s)  /  drive(s)  that  have not  been
changed or  accessed since a certain  date.  You can limit  the search  so  that  it  returns  entire
folders only. In this  case only folders  will  be listed in  which all  files  match the search criteria.
This allows you to identify branches of the file system that are not in use anymore.

Search  for  files  [not
changed / not accessed]

Defines, at which time stamp TreeSize Professional  will  be looking:
last access Date or last write date.

since Define  here  for  how  long  a  file  must  have  been  not  opened  or
changed to be shown in  the result  list.You can either  use a certain
date or a number of days.

Return  complete  folders
only

Returns  as  result  only  folders,  which  (including  all  sub-folder  and
files) were not accessed/changed since the given date.

Like in all searches, you can move all files in the result list which are check-marked to the left of
their  file  name,  to  a  position  in  the  file  system  that  you  may  specify,  by  using  the  Move
Checked  button.  The  Custom  File  Search  offers  more  sophisticated  filter  options  for  the
timestamps of files.

14.4 Temporary File Search - Configuration

This page allows you to search for temporary files. Use the Configure  button to customize the
settings of the Temporary File Search.

Patterns

The  main  part  of  the  Temporary  File  Search  is  based  on  typical  filename  patterns.  You  may
customize these patterns using the Customize  button on the top of  the Temporary  File  Search.
You may change or delete existing patterns as well as add new patterns. Using the check boxes
on the left, you can deactivate certain patterns without deleting them.

WIldcards for pattern building

* Replaces none or arbitrarily many alphanumeric characters

? Replaces exactly one alphanumeric character

Include files with temporary Applications that create a temporary file may inform  the operating
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attribute system  with  a  special  flag  about  this  fact.  With  this  check  box
activated  TreeSize  Professional  will  include  such  files  in  the
search results.

Include  files  that  do  not
belong to a valid account

If a Windows account is deleted, files belonging to this account are
not  deleted automatically and may keep occupying space on  the
hard disks.  With  this  check  box  activated  TreeSize  Professional
will include such files in the search results. Since it is necessary to
get  the owner  of  each file  on  the  searched  disks,  activating  this
option will slow down the scanning process.

Include  Links  without  a
valid target path

With this check box activated TreeSize Professional will check for
.LNK and .PIF files, if the destination path exists.  If  this  is  not  the
case such a file will be included in the search results.

Include  Shortcuts  from
Recent Document Folder

If activated, TreeSize Professional will check for shortcuts from the
recent documents folder.

Add Adds a new pattern in the edit field into the list 

Delete Deletes the pattern selected in the list field on the left.

Like in all searches, you can move all files in the result list which are check-marked to the left of
their file name, to a position in the file system that you may specify by using the Move Checked
button.

14.5 Internet File Search

This  page allows  you to  search  for  temporary  internet  files  like  the  files  in  the  cache  of  the
browsers Internet Explorer, Firefox, Opera and Netscape Navigator.  The search for  temporary
internet files can be automated with the command line option /SEARCH:Internet.

Include cookies Cookies will also be searched and listed.

Like in all searches, you can move all files in the result list which are check-marked to the left of
their  file  name,  to  a  position  in  the  file  system  that  you  may  specify,  by  using  the  Move
Checked button.
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14.6 Duplicate File Search

This  page lists  files  which seem  to exist  more than once on your  disk.  Such  redundant  files
increase the allocated space of your disk, unnecessarily.

You can choose between different strategies on how to identify duplicate files. 
Here is a list of these strategies: 

Compare Size, Name and Date Choose this to identify duplicate files by equal name, size
and last change date.
This  is  much  faster  than  using  checksums  to  indicate
duplicates, but it is also less accurate.

Compare using MD5 Checksum When using MD5 checksums, a so called hash value is
calculated based on the contents of  each file.  Files  with
the same content  will  have  the  same  hash  value,  files
with  different  content  will  almost  certainly have  different
values.
Empty  files  are  ignored,  since  there  is  no  content  to
compare.
This  is  more  accurate  then  comparing  files  by  their
name, size and date but it is also much slower.

Compare using SHA256 Checksum This  works  like  the  MD5-Checksum  mechanism,  but
uses the SHA256 algorithm instead of MD5.  
While  it  is  very  unlikely  that  the  MD5  hash  algorithm
produces  the  same  hash  value  for  different  files,  the
SHA256 algorithm  further  reduces  the  statistical  risk  of
such hash collisions. 
However,  the  SHA256  algorithm  is  significantly  slower
than MD5.

Compare by Name only Choose this  to  find  all  files  with  equal  file  names  only.
This is not really a strategy to identify true duplicate files,
but  this  compare  type  may  be  helpful  when  you  are
searching for  certain  redundancies  or  undesired  copies
(E.g.: Documents which are copied and modified locally).

There are some additional options to customize the duplicates file search for your own desires:

Minimum Size in KB Defines  the  minimum  size  for  files,  which  are  subject  to  the
duplicates search.
Note:  Using  a  minimum  size  will  reduce  the  number  of  files  to
compare.  This  will  increase  the  speed  of  the  search,  especially
when comparing by checksums.

Use Exclude Patterns If checked, the exclude patterns defined on the "Search Options" tab
will be used. Activating this option will also reduce the number of files
to compare and so lead to a performance increase.

Ignore NTFS Hard Links If checked, NTFS hard links will be ignored. This is important as hard
links will otherwise show up as duplicates.
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Like in all searches, you can move all files in the result list which are check-marked to the left of
their  file  name,  to  a  position  in  the  file  system  that  you  may  specify,  by  using  the  Move
Checked button.

Deduplicate:

This button is located right beneath the "Move Checked" button and only visible if the "Duplicate
Files" tab is selected. 
Use this button to replace all checked but one duplicate file in a group by NTFS hard links to the
one remaining file. This will reduce the disk space allocated by your duplicate files (See: NTFS
Hard links). If you check only one file of a group, this file is replaced by a link to the "newest" (file
with the latest last change date) unchecked file of this group. 

In the shown configuration form you may choose a log file to log the performed replacements to.
You can also decide here how to handle files on another hard disk, which cannot be replaced by
NTFS hard links.  You have the option to  ignore those files  or  to  replace them  using symbolic
links.

The context menu of the duplicate files list offers a feature named "Replace Duplicates by Hard
Links". This function works the same as "Deduplicate", besides it handles selected files instead
of checked files.

Important:  Please note that  TreeSize Professional  does  not  offer  the functionality  to  "undo"  a
deduplication! 
All  hard  links  pointing  to  the  same  file  share  the  same  "Security  Description"  (access
permissions). Deduplication will apply a union set of permissions to the one physical remaining
file. Considering this it is difficult to undo a deduplication manually.

14.7 Custom File Search

This register allows you to define a fully customizable file search. You can filter by 

file name 

date
 

size, attributes
 

owner

The tabs of the custom file search that have filters set  (=  have actual  influence on the search
result) are marked by a bold text in their tab.
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14.7.1 Custom File Search - Search for File Names

This sub-tab allows to define a customized file search for file names / file name patterns.

Use  Exclude
Patterns

Advises the program to use the list of excluded file name patterns. Files with a
matching file name will be excluded from the search.

Search
Subfolders

Advises the program to search not only the current folder but also all sub-folder
of the current folder.

The listbox, the text field and the two buttons manage the patterns for the customized file name
search.

Add Adds the pattern entered into the text field to the list of search patterns.

Remove Removes a selected pattern from the list of search patterns.

WIldcards for pattern-building of file names:

* Replaces none or arbitrarily many alphanumeric characters

? Replaces exactly one alphanumeric character

Not  only  parts  of  file  name  are  allow  (e.g.  *.doc),  the  patterns  may  also  contain  parts  of
directories (e.g. *\Windows\System32\*.exe or *\Temp\*.-old). To force the exact match (instead
of a substring match) of a pattern, please put it in double quotes (e.g. "My Music").

To search for directories the "Directory" attribute in the Size / Attribute tab must be checked.

Like in all searches, you can move all files in the result list which are check-marked to the left of
their file name, to a position in the file system that you may specify by using the Move Checked
button.

14.7.2 Custom File Search - Search for File Dates

This sub-tab allows to define a customized file search for files by looking for last change date /
last access date /  creation date.  The searched time period can be determined by defining an
interval between given dates or by defining a duration relative to the current date.

Defining a time period can be done by :

- stating a start date and an end date; the filters will find only files,  with  a  matching date within
these boundaries.
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- stating only a start date; the filters will only find files, with a matching date past the given date.

- stating only an end date;the filters will only find files, with a matching date before the given date.

-  stating,  since how  many  days  must  have  passed  since  the  file  was  (not)  changed  /  (not)
accessed / (not) created.

Changed  /  Not
changed

Looks for files, that were changed / not changed within a given period.

Accessed  /  Not
accessed

Looks for files, that were accessed / not accessed within a given period.

Created  /  Not
created

Looks for files, that were created / not created within a given period.

between... and.... Limits for time intervals.

Since... Defines  a duration,  measured in  days  before today,  that  a  file  were  (not)
changed / (not) accessed / (not) created.

Like in all searches, you can move all files in the result list which are check-marked to the left of
their file name, to a position in the file system that you may specify by using the Move Checked
button.

14.7.3 Custom File Search - Search for File Sizes and Attributes

This sub-tab allows to define a customized file search for files of a certain size  / file with certain
file attributes.

Minimum File Size Sets  the  minimum  file  size  of  wanted  files.  The  associated  combo-box
determines the unit size of the numerical specification.

Maximum  File
Size

Sets  the  maximum  file  size  of  wanted  files.  The  associated  combo-box
determines the unit size of the numerical specification.

Full  Path  longer
than:

Sets the minimum size of a file's path length to be found.



TreeSize Professional76

TreeSize Professional - File Search

Attributes

You can also search for these file attributes and decide, if they should be set or not:

Any The search results will not be filtered by the file attributes, no folders will be
included.

Read only Looks for the "read only" attribute in files.

Hidden Looks for the "hidden" attribute in files.

System Looks for the "system" attribute in files.

Archive Looks for the "archive" attribute in files.

Compressed Looks for the "compressed" attribute in files.

Encrypted Looks for the "encrypted" attribute in files.

Offline Looks for the "offline" attribute in files.

Temporary Looks for the "temporary" attribute in files.

Alternate  Data
Streams

Lists only files that have / do not have  NTFS alternate data streams

Reparse  Points  /
Mount Points

Lists only objects that are (not) flagged as reparse points or mount points

Directory Lists only directories.

Like in all searches, you can move all files in the result list which are check-marked to the left of
their file name, to a position in the file system that you may specify by using the Move Checked
button.

14.7.4 Custom File Search - Search for File Owners

This sub-tab allows to define a customized file search for files of a certain owner / files, with  a
certain owner name pattern.
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The ListBox, the text field and the two buttons to the left of the registers top right  manages  the
search list for the customized files owner name search.

Add Adds the pattern in the text field to the list of search patterns.

Remove Removes a selected pattern from the list of search patterns.

WIldcards for pattern-building of file owner names :

* Replaces none or arbitrarily many alphanumeric characters

? Replaces exactly one alphanumeric character

Like in all searches, you can move all files in the result list which are check-marked to the left of
their file name, to a position in the file system that you may specify by using the Move Checked
button.

14.8 Move checked files

This button allows you to move all files in the search result lists, which are checked left of their
file name, to a new destination that you may specify. 

If you choose a file system location as target for the relocation process,  all  files  will  be moved
there under preservation of the original file system structure. You may also move the checked
files to a ZIP file. Optionally all performed operations can be written to a log file.

TIP: You can easily check a group of  files  by keeping the space bar  pressed or  by selecting
multiple files with the Shift or Ctrl key and then use the context menu.

Move Operations:

Move checked files to
Recycle Bin

Moves check-marked files directly to  the Recycle Bin.  To definitively
delete these files, you have to empty the Recycle Bin.

Delete checked files
from disk

Deletes  check-marked  files  after  a  confirmation  prompt  has  been
displayed.

Move checked files to
ZIP file

Moves  check-marked files  to  a  ZIP  file  you  specify  in  the  edit  field
bellow.  ZIP  files  containing  Unicode  paths  can  only  be  unzipped
properly by Unicode compatible ZIP tools like WinRar or WinZip (See:
"Unicode Zip files").

Move checked files to
path or burn to disc

Moves  check-marked  files  to  the  path  you  specify  in  the  edit  field
bellow,  or  burns  them  to  a  writable  media.  Optionally  the  original
directory structure will be preserved in the destination path. Optionally
the  security  attributes  can  be  copied  as  well.  If  this  option  is  not
active,  the  moved  files  will  inherit  the  security  attributes  from  the
parent elements. A further option allows  to  leave shortcuts  or  link at
the original position, see below.

Copy checked files to
path or burn to disc

Copies  check-marked  files  to  the  path  you  specify  in  the  edit  field
bellow,  or  burns  them  to  a  writable  media.  Optionally  the  original
directory structure will be preserved in the destination path. Optionally



TreeSize Professional78

TreeSize Professional - File Search

the  security  attributes  can  be  copied  as  well.  If  this  option  is  not
active,  the  moved  files  will  inherit  the  security  attributes  from  the
parent elements.

Pass files to executable
as parameter

For every checked file an executable file will be called and the full path
of  the file  will  be  passed  as  parameter  on  the  command  line.  The
executable  file  may  also  be  a  batch  file,  a  VBScript  or  something
similar. The Windows Scripting FileSystemObject offers powerful and
easy to use capabilities for file system and path operations.

Move Options:

Delete empty directories
after moving

Deletes all folders that have been emptied due to this move operation.

Preserve directory
structure

If this option is activated, the file system structure will  be kept  at  the
destination. If this option is unchecked, all files will be moved into one
folder.
Note: Only available for "Zip" and "Move to path" operation.

Include directory with
drive letter to avoid
name collisions

Indicates if a directory named like the source drive should be included
in the destination path.  Activate this  option to  avoid  name  collisions
when moving files form several drives.

Automatically rename
existing files

If this  option is  activated,  files  will  be automatically renamed if  a  file
with the same name already exists in the destination.
Note: Only available for "Zip" and "Move to path" operation.

Preserve permissions of
the original file

If  this  option is  activated,  the permissions  of  the  original  file  will  be
used for the file in the new location
Note: Only available for "Move to path" operation.

Leave shortcut/link at
original location pointing
to new location

If  this  option  is  activated,  a  shortcut  or  link  will  be  created  at  the
original location that points  to  the new  location to  where the file  has
been moved.   If  you choose to  leave a link and the files  are on  the
same  partition,  then  a  hardlinks  will  be  created.  If  creation  of  a
hardlink is not possible, a symbolic link is used under Windows Vista
and  later.  If  this  is  not  possible  too,  a  Windows  shortcut  will  be
created instead as fallback.
Note: Only available for "Move to path" operation.

Logging:

Number of checked
objects

States the total number of check-marked objects for your information.

Total size of checked
files

Displays the total size of all check-marked files. 

Log performed
operations to:

Produces  a log file  with  the name of  your  choice under  the  path  of
your choice. Environment variables like %DATE% or %TIME% can be
used in the file name.

http://msdn.microsoft.com/en-us/library/6tkce7xa%28v=VS.85%29.aspx
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Logging your  file  moving /  archiving /  deleting activities  provides  lucidity and  security  for  your
system maintenance and is highly recommended.

The  log  produced  by  TreeSize  Professional  shows  all  the  necessary  details  to  trace  a
maintenance act and will be saved in txt-format. A typical log file looks like this :

TreeSize  Professional  is  starting  move  operation  on  30.11.2007
10:50.

Moving the files to: C:\Obsolete\

"C:\WINDOWS\BGInfo.bmp" => "C:\Obsolete\C\WINDOWS\BGInfo.bmp"

"C:\WINDOWS\Help\article.chm"  =>  "C:
\Obsolete\C\WINDOWS\Help\article.chm"

Finished at 30.11.2007 10:50.

Freed Space: 7407476 Bytes (7 MB)

14.8.1 Unicode Zip files

TreeSize Professional is able to zip files with file names including characters which are not part
of your activated code page (Unicode file names). To restore this Unicode decoded Zip files you
need an Zip tool that can handle Unicode encoding.

Here is a list of tools we tested:

Unicode compatible: Not Unicode compatible:

WinRAR (V3.8 or higher) Windows Integrated Zip tool (XP / Vista / Server 200X / Windows
7)

WinZip (V 11.2 or higher) TUGzip (tested with V 3.5)

7-Zip (V4.6 or higher) IZArc (tested with V 3.81)

Filzip (tested with V 3.06)

WinAce (tested with V2.61)

15 Schedule TreeSize Tasks

Schedule Dialog

Command Line Options

http://de.wikipedia.org/wiki/Unicode
http://www.rarlab.com/
http://www.winzip.com
http://www.7-zip.org/
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15.1 Schedule Dialog

It is  possible to schedule tasks using the Scheduled Tasks  folder of  Windows.  The dialog below
will help you to create a scheduled TreeSize Professional  task with  the appropriate  command
line options. This feature is only available in the Professional Edition.

Path to scan Enter the path(s) that should be scanned here. Multiple paths have to be
quoted and separated by a blank.

Export Here  you  can  choose  which  of  the  export  options  that  TreeSize
Professional supports should be used for the scan. The export  options
correspond to the command line options.

Options Here you can specify further  options  for  the scan and activate certain
actions that should be executed after the scan.

Scheduler Specify here when and in which interval the task should be executed.

Command Line Here you can see the full command line of the task. If you don't want to
use the Scheduled Tasks  of Windows, then you can copy this command
line to the clipboard and use it elsewhere, e.g. in a batch file.

The created command line call of TreeSize.exe can be added to the Scheduled Task  of Windows
by using the Save Task button. 
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Edit Tasks

Tasks can be edited on the "All Tasks" tab on top of the window or using the "Scheduled Tasks"
applet in the Windows Control panel.

15.2 Command Line Options

The  Professional  Edition  of  TreeSize  accepts  command  line  options  which  allow  you  to  do
scheduled  scans  or  to  have  the  results  of  a  scan  on  your  monitor  the  next  morning.  The
Schedule dialog will help you to compile a command line with the option below. These option are
not available in the Personal Edition.

treesize.exe [/APPENDTOFILES] [/ARCHIVEBITFILESONLY] [/(BAR|PIE)CHART filename] [/

COMPARE filename] [/DATE] [/EMAIL] [/EXCEL filename] [/EXPAND [level|xxMB]] [/

EXTENSIONSLIST filename] [/FILEAGESCHART filename] [/FILTER pattern1;pattern2;...] [/

GROUPSCANS] [/FOLLOWREPARSEPOINTS] [/HTML filename] [/HISTORYCHART filename] [/

LISTSEPARATOR char] [/MOVETO (path|ZIP-file|Recycle Bin|Executable)] [/NOGUI] [/

NOHEADERS] [/NOUNITS] [/OPEN] [/PRINT] [/SAVE filename] [/SCAN textfile] [/SEARCH[:Start

[xmlfile]|:Internet] ] [/SIZEUNIT N] [/SHEETNAME text] [/TITLE text] [/TOPFILESLIST

filename] [/TREEMAP filename] [/USERSLIST filename] [/XML filename] Directories

/
APPENDTOFIL
ES

If  this  option is  used,  TreeSize Professional  will  always  append its  output  to
existing files when doing an export, e.g. using /SAVE or /EXCEL.

/
ARCHIVEBITFIL
ESONLY

This option will include only files in  the scans  which have the archive bit  set.
This option can be very useful if you want to calculate the size of a backup. In
this case, you can create a shortcut on your desktop or in your start menu that
will automatically start calculating the size of your backup:

treesize /ARCHIVEBITFILESONLY "\\Server\Backup\This"

/BARCHART Saves the bar chart of the scanned directory to a bitmap, GIF or JPEG file. The
file  type depends  on the extension of  the  specified  file  name.  This  example
creates a JPEG image of the bar chart for drive C:

treesize /BARCHART C:\Documents\c.jpg C:\

/COMPARE Compares the scanned path with a saved XML report. The following example
scans drive C: and compares the result with a saved XML report for this drive:

treesize /COMPARE "C:\temp\TSP XML\c.xml" C:\

Alternatively,  you can compare two already saved XML  reports  e.g.  "c1.xml"
and "c2.xml" by using this command :

treesize /OPEN "C:\temp\TSP XML\c1.xml" /COMPARE "C:\temp\TSP XML\c2.
xml"

The /OPEN command prepares the comparison of the two files by expanding
the first file (c1.xml into a scan file. The second file ("c2.xml") will be compared
to this expanded scan file, just like it would happen, if we would compare c2.
xml to a "real" scan.

/ This option will include only files in the scans,  which were created during the
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CREATEDPAS
TDAYSONLY

past number of days, that are given in the argument.

treesize /CREATEDPASTDAYSONLY 8

Here, this option will only include files into the scan, which were newly created
during the last 8 days.

It corresponds to the option "Include only Files Created in the Past XX Days" in
the Options dialog.

/DATE This switch will add the current date to all file names occurring after  it  on the
command line. This is useful if you want to  do scans  regularly every night  or
every  weekend.  If  you  want  the  date  included  in  all  filenames,  then  /DATE
should be your first command line option. The following example will scan
the  network  path  \\host\share  and  save  the  result  to  a  file  like  C:
\scans\name_03-12-20_1550.xls:

treesize /DATE /EXCEL "C:\scans\name.xls" \\host\share

/EMAIL Sends the collected data to  the given email  address  using MAPI.  Your  email
application must  be configured properly  for  MAPI.  Multiple  recipients  can  be
separated with semicolons or commas. Example:

treesize /EMAIL sysadmin@company.com \\SERVER\C$

If MAPI is not sufficient for you, we recommend to save the data to  a  file  and
use a command line based mailing tool like the free BLAT. A batch file to send
an HTML mail could look like this:

"C:\Program Files (x86)\JAM Software\TreeSize Professional\TreeSize.exe"
/HTML "D:\Temp\DriveC.HTML" C:\
BLAT "D:\Temp\DriveC.HTML" -to to@jam-software.com -f from@jam-software.
com -server mail.jam-software.com

An  exported  Excel  file  can  also  be  attached  and  the  comands  can  be
concatenated using the & operator:

START /WAIT treesize /EXCEL D:\treesize_c.xls C:\ & BLAT - -to to@jam-
software.com -f from@jam-software.com -server mail -subject "TreeSize
scan of drive C" -attach D:\treesize_c.xls -body "See attachment"

/EXCEL Exports the collected data to Excel and saves it under the given file name.  The
application will terminate itself after saving. Example:

treesize /EXCEL "C:\Documents\c.xls" C:\

If the file name already exists, the file will be opened and a new sheet will be
added. For the File Search the results of each search type will be placed in a
separate sheet and existing files will be overwritten. To prevent this you need
to use the command line option /APPENDTOFILES in addition.

/EXCLUDE This  option  allows  to  specify  patterns  for  files  and  folders  that  should  be
excluded  from  a  scan.  Multiple  exclude  patterns  can  be  separated  using  a
semicolon. If one or more of the patterns contain spaces, the complete pattern
string  must  be  set  into  quotes.  This  command  line  option  is  equal  to  the
Exclude list in the Options dialog. The following example will ignore folders that
end with ".001" and folders that are named ".system":

http://www.blat.net
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treesize /EXCLUDE "*.001;.system" \\server\Users

/EXPAND This  option  lets  you  specify  how  many  levels  in  the  directory  tree  will  be
expanded  after  scanning.  If  you  don't  specify  a  number,  all  folders  will  be
expanded. Instead of a directory level you can also indicate an amount in MB.
In this case all folders larger than the given amount will be expanded. The unit
"MB" must follow the number without a blank. The following example will scan
the folder "H:\user", expand all folders larger than 10MB and save the result to
the Excel file C:\Results\Allusers.xls:

treesize /EXCEL "C:\Results\Allusers.xls" /EXPAND 10MB H:\user

/
EXPORTDRIVE
SLIST

This option allows to export the contents of the drives panel to a text or csv file.

treesize /EXPORTDRIVESLIST "C:\Results\AllDrives.csv"

/
EXTENSIONSLI
ST

This option allows you to save the statistics on file extensions / file types of the
scanned  file  system  branch  to  an  Excel,   text  or  CSV  file.  The  following
example scans drive C: and creates an Excel file in C:\Temp with the statistics
of the file types on this drive:

treesize /EXTENSIONSLIST "C:\temp\C_filetypes.xls" C:\

/
EXTENSIONSC
HART

Saves the small chart that is  visible on the bottom of the "Extensions" page to
a file.

/
FIL
EA
G
ES
C
HA
RT

Saves the chart on the "File  Ages"  tab of  the scanned directory to  a  bitmap,
GIF or JPEG file.  The file  type depends  on the extension of  the specified file
name. This example creates a JPEG image of the bar chart for drive C:

treesize /FILEAGESCHART "C:\Documents\c_file_ages.jpg" C:\

/FILTER Allows to set a file filter so that only files with certain extensions, e.g. .MP3 or .
DOC, will be counted. Multiple patterns may be passed, you can use spaces,
commas  or  semicolons  as  separator  between  the  patterns.  The  following
example will search for AVI and MP3 files in the users directory on the server:

treesize /EXCEL "C:\Results\MediaUsers.xls" /FILTER "*.mp3;*.avi" \
\Server\Users

When performing a File Search, you can also use the /FILTER command line
switch to specify the patterns of the Custom File Search. To perform  a more
complex  custom  file  search  save  search  options  to  a  file  and  pass  the
resulting XML file at the command line after /SEARCH.

Note: When using a pattern without any wildcards ("*" or "?") there will be a "*"
added at the beginning and at the end of the pattern!

/
FOLLOWREPA
RSEPOINTS

When  adding  this  switch  to  the  command  line,  TreeSize  Professional  will
follow mount points and symbolic links when scanning a file system tree.
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/
GROUPSCANS

Using  this  command  line  switch  will  group  all  scanned  directories  under  a
virtual root folder. Use /GROUPSCANS FALSE if you want to  ensure that  no virtual
root folder is used.

/
HISTORYCHAR
T

Saves the chart on the "History" tab of the scanned directory to a bitmap, GIF
or JPEG file. The file type depends on the extension of the specified file name.
This example creates a JPEG image of the bar chart for drive C:

treesize /HISTORYCHART "C:\Documents\c_history.jpg" C:\

/HTML Saves the collected data to a HTML file which can be viewed with  any HTML
browser  later.   If  you also have a /PIECHART  or  /BARCHART  parameter  in
your command line, the image will be included in the HTML file.  The following
example will generate an HTML report for the drive C: and saves it to D:\html:

treesize /DATE /HTML "d:\html\treesize.html" /PIECHART "d:
\html\treesize.jpg" C:\

If you would like to scan and export multiple drives or folders, we recommend
that  you  either  use  one  call  for  each  drive  or  folder,  or  that  you  use  the
command line option like in the following example:

treesize /HTML "d:\html\drive-c.html" /PIECHART "d:\html\drive-c.jpg" C:
\ /HTML "d:\html\drive-d.html" /PIECHART d:\html\drive-d.jpg D:\

/
LISTSEPARAT
OR

Allows to  define the separator  that  is  used when exporting text  or  CSV files.
Text  files  use  the  tabulator  by  default,  CSV-files  the  list  separator  from  the
regional settings of the control panel. Please specify a single character or the
string "TAB" for tabulator. Examples:

treesize /LISTSEPARATOR ; /SAVE "C:\Results\c.csv" C:\

treesize /LISTSEPARATOR TAB /SAVE "C:\Results\c.csv" C:\

/MOVETO File  Search: Allows to move the results of a file search to  a  ZIP  file,  another
path, the recycle  bin  or  an executable file.  It  can only be used in  connection
with a /SEARCH:Start command line option. To move the files  to  the recycle
bin, specify the name of the recycle bin as seen in the Windows Explorer. The
following command will search drive C:\ for internet cache files and move them
to a ZIP file called ObsoleteFiles.zip:

treesize /SEARCH:Internet /MOVETO "C:\temp\ObsoleteFiles.zip" C:\

This call deletes the files instead:

Treesize /SEARCH:Internet /MOVETO "Recycle Bin" C:\

This example will use saved search options and move all files that were found
on Drive C: to a path E:\Obsolete Files:

Treesize /SEARCH /MOVETO "E:\Obsolete Files" SearchOptions.xml

This  example  uses  previously  saved  search  options  with  the  file  name  "
ArchiveOptions.xml"  and passes  every  matching  file  path  to  the  batch  file  "
Archiver.BAT" which e.g. may trigger an archiving process:

Treesize /SEARCH /NOGUI /MOVETO "Archiver.BAT" ArchiveOptions.xml

For ZIP-files the /DATE parameter can be used to add the current date to  the
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ZIP file name, See also: Move checked files

/NOGUI No window will  be shown and the application will  not  appear  in  the task bar.
Useful for background scans. Caution: Use this switch only if you have tested
the  rest  of  the  command  line  options  because  error  messages  cannot  be
displayed  in  this  mode.  However,  it  tries  to  log  errors  in  the  event  log  of
Windows. Make sure that this is the first command line switch when using it.

/NOHEADERS Omits  the header  lines  that  are usually written on top of  exported files.  This
makes it easier to get plain data for postprocessing. This option can be used
for the File search as well.

/NOUNITS Omits  the units  that  are usually written  after  size  values.  Use  /SIZEUNIT  to
define  the  unit  that  will  be  used,  adding  /SIZEUNIT  0  will  export  plain  byte
values. This makes it easier to get plain data for postprocessing.

Note:  This  command  line  will  only  effect  exports  of  the  directory  tree,
generated by  using  the  "/SAVE",  "/EXCEL",  "/HTML"  or  "/PRINT"("/PRINT1")
options. "/EXTENSIONSLIST", "/USERSLIST" or "/TOPFILESLIST" will  not  be
effected!

/OPEN Opens a saved XML report on application start. Example:

treesize /OPEN C:\Reports\Drive_C.xml

/OPTIONS Use  this  parameter  to  apply  former  exported  user  settings  to  TreeSize
Professional.  User  settings  can  be  exported  at  "Tools  >  Options  >
Miscellaneous Settings".

treesize /OPTIONS "C:\Temp\User Settings.xml"

/PIECHART Saves the pie chart of  the scanned directory to  a  bitmap,  PNG or  JPEG file.
The following example will scan the drives C:\ and D:\ and produce a chart for
each one in PNG format:

treesize /PIECHART "C:\Temp\c.png" C:\ /PIECHART "C:\Temp\d.png" D:\

/PRINT Prints a report for the scanned folder to the default printer. The application will
be terminated after printing. Usage example:

treesize /PRINT C:\ D:\

/PRINT1 Prints only the first page of a report for the scanned folder to the default printer.
The application will be terminated after printing. Usage example:

treesize /PRINT1 \\SERVER\USERS

/RESTRICTED Starts TreeSize Professional in a restricted mode in which many features are
disabled that  are not  of  interest  for  "normal"  (non  admin)  users.  Among  the
disabled features  are:  Check for  Update,  Open Software applet  of  Windows
Control  Panel,  Schedule  TreeSize  scans,  connect  network  drive,  configure
Windows  System  Restore,  exports  and  apply  NTFS  compression.  You  can
supply a path that  should be scanned,  e.g.  the user's  home directory,  at  the
command line or using the Startup Paths  in  a  saved configuration file.  If  you
additionally pass the command line option /READONLY the user won't be able
to  delete  or  move  files  in  TreeSize  Professional,  it  will  be  usable  only  as
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reporting tool.

/SAVE Saves the results to a text or CSV file after scanning or searching is finished.
The application will  terminate  itself  after  saving.  This  example  will  save  the
results of the File Search to a CSV file:

treesize /SEARCH:Start /SAVE "C:\Results\c.csv" C:\

/SCAN Scans  all  paths  that  are found in  the text  file.  The text  file  must  contain  one
path  per  line.  The  following  example  scans  all  paths  that  are  found  in  D:
\PathsToScan.txt and writes each scan result to a separate sheet in an Excel
File with today's date:

treesize /EXCEL d:\Results\%DATE%.xlsx /SCAN D:\PathsToScan.txt

You may also call TreeSize in a FOR loop with one of  the paths  only,  please
find an example below.

/SEARCH File  Search:  Opens  the File  Search window  of  TreeSize  Professional.  If  ":
Start" is added to this command line option, the search is started immediately
with the settings used the last time. Files that are added to the result lists will
be checked automatically. A previously saved XML file containing settings may
be passed, these settings will  then be used to  perform  the search.  The next
example performs the search with settings that have previously been saved to
the file SearchSettings.xml and save the results:

treesize /SEARCH /SAVE "T:\result.txt" SearchSettings.xml

If  ":Internet" is  added to this command line option,  it  will  start  searching for
temporary internet files  and delete them.  The drives  activated during the last
regular  scan  will  be  scanned,  a  special  set  of  drives  and  paths  can  be
specified on the command line (separated with blanks). Usage example:

treesize /SEARCH:Internet

The settings of the last performed file search will be used.  However,  you can
specify the search patterns  for  the temporary file  search  using  the  /FILTER
command line option.  Tip:  You  can  use  the  /SAVE  command  line  option  to
save the results of the file search to a text or CSV file.

/SIZEUNIT N This option can be used to specify the unit that should be used for  displaying
size values: N can have the values 0 to 4 which mean: 0 = Bytes, 1 = KB, 2 =
MB, 3 =  GB.  Without  this  option the value will  be used that  was  set  the last
when the TreeSize File Search was used.

/SHEETNAME Allows to specify the name of the sheet that will be added to an Excel file when
using  the  /EXCEL  command  line  switch.  Please  note  that  an  Excel  sheet
name  must  be  unique  in  an  Excel  file  and  certain  special  characters  like
slashes, backslashes and colons are forbidden in Excel sheet name. TreeSize
Professional  will  always  create  a  unique  sheet  name  by  replacing  invalid
character with underscores and by adding date and time if necessary.

/TITLE Can be used to change the title of the printed or  exported report.  That  allows
you  to  supply  additional  information  to  the  user  when  using  TreeSize
Professional in an automated environment.
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treesize /TITLE "This is drive C on Server3" /PRINT \\Server3\C$

/TOPFILESLIST This option allows to save the contents of the Top 100 list to an Excel, text or
CSV file.

treesize /TOPFILESLIST C:\temp\C_top_files.txt C:\

/TREEMAP Saves the treemap as Bitmap, GIF or JPEG-File.

treesize /TREEMAP "C:\Dokumente\treemap.jpg"  C:\

/USERSLIST This option allows  you to  save the statistics  showing the results  grouped by
username to an Excel, text or CSV file. The following example scans drive C:
and creates an Excel file in "C:\Temp" with the statistics  of  the users  on this
drive:

treesize /USERSLIST "C:\temp\C_users.xls" C:\

/USERSCHART Saves the small chart that is visible on the bottom of the "Users" page to a file.

/XML Saves the results to a XML file that can be loaded again later and can be used
for comparisons

treesize /XML "C:\Results\Allusers.xml" H:\users\

This option can be combined with /EXPAND to limit the exported directories. 
Note:  When  loading  a  limited  XML  export  to  TreeSize  Professional  only
exported directories will be shown!

Directories At the end of the command line, you may pass one or more paths that should
be scanned by TreeSize Professional. The wildcards "*"  and "?"  are allowed.
Example:

treesize H:\users\A*

To  start  one  instance  for  each  folder,  you  may  use  the  Windows  for-
command like this:

for /D %i in (C:\Windows\S*) do @start /w treesize.exe %i

In  case an error  occurs,   it  will  be  returned  as  Windows  error  code  in  the  exit  code  of  the
process. In filenames for the export as well as in the scanned paths environment variables can
be used.

Scanning Multiple Directories

If you need to scan multiple directories, it can be a good idea to merge several calls in a Batch
file, for example:

START /WAIT "C:\Program Files\JAM Software\TreeSize Professional\treesize.exe" /EXCEL D:
\Share1.xls \\Server\Share1

START /WAIT "C:\Program Files\JAM Software\TreeSize Professional\treesize.exe" /EXCEL D:
\Share1.xls \\Server\Share1

START /WAIT "C:\Program Files\JAM Software\TreeSize Professional\treesize.exe" /EXCEL D:
\Share1.xls \\Server\Share1

The command "START WAIT"  make sure  that  the  jobs  start  sequentially.  Not  starting  the  jobs
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parallel  is  usually  better  because  a  single  job  makes  better  use  of  caches  and  system
resources. It is also possible to store the shares that should be scanned in a text file and use the
 FOR command:

FOR /F %%p IN (Paths.txt) DO START /WAIT Treesize.exe /EXCEL "c:\temp\TreeSize-Reports-%
DATE%.xls" "%%p"

FOR  /F  "tokens=1"  %%i  IN  (Shares.txt)  DO  START  /WAIT  Treesize.exe  /NOGUI  /EXCEL  "c:
\temp\%%i.xls" /exclude ~snapshot "\\Server\%%i"

(Note:  The double percent  characters  are required in  batch-files,  on the command line use a
single percent only)

Scheduled Start

You can use the Scheduled Tasks  folder  of  Windows  to  run TreeSize Professional  daily at  a
certain time, the Schedule dialog of TreeSize Professional will help you setting up a scheduled
task.

You can also use the at command to perform scheduled scans. If you for example want to scan
the drives C: and E: next night at 03:00 a.m. and save the results to an Excel file, you must enter
the following on the command line:

at 03:00 "C:\Program Files\JAM Software\TreeSize Professional\treesize.exe" /EXCEL "c:
\temp\tsp.xls" /EXPAND 2 c:\ e:\

If you want to see the results of the file search on your screen when you come into your office in
the morning, you should enter something like:

at 06:00 /INTERACTIVE "C:\Program Files\JAM Software\TreeSize Professional\treesize.exe"
/SEARCH:Start

Read  more  about  the  at  command  in  the  Windows  help.  Error  messages  occurring  during
scheduled scans are listed in the Event Log of Windows. 

Windows Scripting Host

If  you  intend  to  use  the  Windows  Scripting  Host  (WSH),  your  command  to  start  TreeSize
Professional will look like:

Set Shell = CreateObject("WScript.Shell") 
Shell.Run """C:\Program Files\TreeSize Professional\treesize.exe"" /XML c:\temp\drive_c.
xml c:\" 
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Copyright ©1995-2012 by Joachim Marder e.K.

JAM Software GmbH
Am Wissenschaftspark 26
54296 Trier
Germany

FAX: +49-651-145653-29

WWW: http://www.jam-software.com

http://www.jam-software.com


Copyright & Contact 89

TreeSize Professional - Copyright & Contact

Support: http://www.jam-software.com/customers/contact.php

Email: treesize@jam-software.com

VAT ID No.: DE234825349

Commercial Register No.: HRB 4920 (AG Wittlich)

Managing Director: Joachim Marder

http://www.jam-software.de/customers/contact.php?language=EN
mailto:treesize@jam-software.com


TreeSize Professional90

TreeSize Professional - Index

Index
 
 6 

64 bit version     23

 
 A 

Access control     21

Access Date     74

Administrator     21

ADS     21

Age of Files     40, 60

Allocated Space     25, 46

Alternate data streams     21

Alternate Data Strems     75

Archive Attribute     54, 75

Attributes     75

Author     88

Automatic Updates     45

Automatic updates during scanning     52

 
 B 

Bar Chart     35

Biggest files     63, 69

Bold folders     52

Branch Menu     45

Browser Cache Files     71

Bytes per cluster     20

 
 C 

Change Date     74

Chart Type     46

Charts     35, 37

Checksum     72

Citrix Server     25

Cluser     25

Cluster size     20

Columns     55

Command Line Options     81

Compare file content     72

Compare Reports     43

Compressed Files     75

Compressed files and folders     52

Compression     21

Configure file groups     61

Contact JAM Software     88

Contents     1

Context Menu     48

Cookie     71

Cookies     71

Copy to clipboard     44

Copyright     88

Creation Date     74

Custom file search     73, 74, 75, 76

 
 D 

Data export     44

Date     74

Date values     55

Decimals     46

Deduplication     72

Delete Files     77

Details     38

Diagram     35

Directory Tree     35

drives     68

Drives Panel     35, 46

Duplicate files     72

 
 E 

Encrypted Files     75

Equal files     72

Error messages     53

Excel 2007     44

Excel export     44

exclude     68

Exclude from scanning     54

Expand directory trees     48

Expanding big folders     48

Expanding directory tree     48

Explorer Context Menu     59

Export     29

Export complete list of files     44

Export data     44

Export Options     55

Extensions     39

 
 F 

FAQ     23

FAT file system     20

File Ages     40

File Extensions Statistics     25, 39, 53

File Groups     61

File list     48



Index 91

TreeSize Professional - Index

File lists     44

File Menu     43

File name     74

File name pattern     74

File owners statistics     53

File Search     30, 63

File Search Options     68

File Search, General     62

File System Tree     35

File Types     39

Filter     53

Find duplicate files     72

Firefox     71

 
 G 

gradient bar     52

Group by extensions     53

Group by users     53

Group file extensions     61

Group Scans     47, 81

 
 H 

Hard links     21

Hard links incorrect     25

Hidden Files     75

History     42

History data     25

 
 I 

Installation     1, 25

Internet Explorer     71

Internet Files     63, 71

 
 J 

JAM Software     88

 
 L 

Last access date     18, 55

Last accessed     74

Last change date     55

Last changed     74

Links     21

Linux scans     23

List separator     81

Lists of files     44

Load Report     43

Log file     77

 
 M 

Maximum size     75

MD5 checksum     72

Menu, File Search     65

Menus     43

Minimum size     75

Mountpoints     53

Move Checked button     77

Move Files     77

 
 N 

NFS scans     23

NTFS file system     21

NTFS Kompression     48

 
 O 

Obsolete Files     63, 70

Occupied Space     25

Offline Files     54, 75

Oldes Files     63

Oldest files     70

Opera     71

Operating systems     23

Options     51, 52

Ordering     88

Overnight Scans     80

Overview     1

Owner     76

Owners     39

 
 P 

paths     68

Pie Chart     35

Plain Numbers     55

Portable installation     1

Print Chart     23

Print directory     23

Printer Setup     43

Printing     23, 29

Program Start     59

Purchasing     23, 88

 
 Q 

Quickstart     1



TreeSize Professional92

TreeSize Professional - Index

 
 R 

RAID arrays     25

Read only Files     75

Recent Changes     3

Recycle Bin     77

Registration     23, 88

Removing small folders     48

Reparse points     21

Replace duplicates by hard links     72

Report     23

 
 S 

Samba scans     23

Save Report     43

Scan Option     68

Scheduled Scans     80

search domain     68

Search For Files     63

search network     68

search PC     68

search types     68

Settings     51

Setup     1

SHA256 checksum     72

Shell Extensions     20, 59

Silent Installation     25

Sorting     47

Sparse files     21

Startup     59

Support     88

Symbolic links     21, 53

System Files     75

System requirements     23

System Restore     25

System Volume Information     25

 
 T 

Temporary Files     63, 70, 75

Threads     53

Tips & Annotations     18

Toolbars     33, 46

Tools Menu     47

Tooltips     52

Top 100 Files     41

Tree Map     37

TreeSize Explorer Column     20

 
 U 

Unattended Installation     25

Unicode     79

Unicode enabeld Zip tools     79

Unicode Zip files     79

Unit     46

Unix scans     23

Unused files     63

Update scan     45

USB stick installation     1

User defined cluster size     53

User Interface     32

Username     76

Users     39

 
 V 

View Menu     46

Virtual Roots     47

Visible columns     55

 
 W 

Wasted Space     20, 46

What's New?     3

Windows Explore     59

Windows Explorer     20

Windows System Restore     25

Windows versions     23

 
 X 

XML Export     43

XML Report     81

 
 Z 

ZIP File     77


	Overview
	Installation
	Quickstart
	What's New
	Tips & Annotations
	TreeSize Column for Explorer
	Wasted Space
	Notes on NTFS
	Printing
	FAQ
	General / Registration
	Main Program
	Printing / Export
	File Search

	Windows & Tabs
	Toolbars
	Directory Tree
	Drive Panel
	Chart
	Tree Map

	Details
	Extensions
	Users
	Age of Files
	Top 100 Files
	History

	The Menus
	File Menu
	Export Submenu
	Edit Menu
	Branch Menu
	View Menu
	Sort Menu
	File Search Menu
	Tools Menu
	Context Menu

	Options
	View Tab
	Scan Tab
	Include / Exclude Tab
	Columns / Export Tab
	Startup Tab
	Miscellaneous Tab
	Age of Files Tab
	File Groups Tab

	File Search
	The File Search Window
	File Search Menu
	File Search Options

	Biggest File Search
	Oldest File Search
	Temporary File Search - Configuration
	Internet File Search
	Duplicate File Search
	Custom File Search
	Custom File Search - Search for File Names
	Custom File Search - Search for File Dates
	Custom File Search - Search for File Sizes and Attributes
	Custom File Search - Search for File Owners

	Move checked files
	Unicode Zip files


	Schedule TreeSize Tasks
	Schedule Dialog
	Command Line Options

	Copyright & Contact

